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1.0 GENERAL INFORMATION

1.1 Forward

Congratulations, the C6000™ microprocessor based
A/C system controller covered by this manual is
designed and manufactured by Stulz Air Technology
Systems, Inc. (SATS) using the latest, state-of-the-
art control technology. Recognized as a world leader,
SATS provides precision cooling systems and controls
with the highest quality craftsmanship using the finest
materials available in the industry. The controller will
provide years of trouble free service if installed and
maintained in accordance with this manual. Damage
to the unit from improper installation, operation or
maintenance is not covered by the warranty.

This manual contains information for operation, main-
tenance, troubleshooting and repair of the controller.
STUDY the instructions contained in this manual. They
must be followed to avoid difficulties. Spare parts are
available from SATS to insure continuous operation.
Using substitute parts or bypassing electrical com-
ponents in order to continue operation is not recom-
mended and will VOID THE WARRANTY. Due to
technological advancements, components are subject
to change without notice.

C6000 controllers are designed primarily to precisely
operate, control and monitor SATS precision air condi-
tioning systems. The controller provides the user inter-
face to manage the A/C system. Any use beyond this
is deemed to be not intended. SATS is not liable for
any damage resulting from improper use. All C6000
controllers are designed for indoor use.

1.2 Safety Summary

1.2.1 General

SATS uses NOTES along with CAUTION and
WARNING symbols throughout this manual to draw
your attention to important operational and safety
information.

A bold text NOTE marks a short message in the infor-
mation to alert you to an important detail.

A bold text CAUTION safety alert appears with infor-
mation that is important for protecting your equipment
and performance. Be especially careful to read and
follow all cautions that apply to your application.

A bold text WARNING safety alert appears with
information that is important for protecting you from
harm and the equipment from damage. Pay very
close attention to all warnings that apply to your ap-
plication.

A safety alert symbol A accompanies a general
WARNING or CAUTION safety statement.

A safety alert symbol accompanies an electrical
shock hazard WARNING or CAUTION safety state-
ment.

1.2.2 Safety Summary

The following statements are general guidelines fol-
lowed by warnings and cautions applicable through-
out the manual.

CAUTION /\

Prior to operating the unit, read and understand all
instructions, recommendations and guidelines con-
tained within this manual.

CAUTION /\

All adjustments, maintenance and/or repairs must be
performed by a qualified technician.

NOTE

We recommend contacting SATS Product Support
Group for assistance with adjusting or servicing your
A/C unit.

WARNING

If a fault occurs when operating the A/C unit or
adjusting control parameters, it must be corrected
immediately in accordance with the troubleshooting
instructions for the A/C unit.

CAUTION /\

Equipment may contain components subject to
Electrostatic Discharge (ESD). Before attempting to
mount or service these electronic devices, ensure
you have no charge built up by touching a ground
source. When possible, use a wrist-grounding strap
when working on or near electronic devices.

(©July, 2008)
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1.3
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Product Warranty

SATS offers a two year standard limited warranty as stated below.
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2-Year Standard Limited Warranty:

Stulz Air Technology Systems, Inc., warrants to the original buyer of its products that the
goods are free from defects in material and workmanship. Stulz Air Technology Systems,
Inc.’s obligation under this warranty is to repair or replace, at its option, free of charge to the
customer, any part or parts which are determined by Stulz Air Technology Systems Inc. to be
defective for a period of 24 months from date of shipment when a completed start-up form
has been submitted to Stulz Air Technology Systems, Inc. within 90 days from shipment. In
the event that a completed start-up form is not received by Stulz Air Technology Systems, Inc.
within 90 days from shipment, the company’s obligation will be for a period of 12 months from
date of shipment. Parts repaired or replaced under this warranty are shipped FOB Factory,
and warranted for the balance of the original warranty period or for 90 days from the date of
installation, whichever is greater.
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Stulz Air Technology Systems, Inc.’s warranty does not cover failures caused by improper
installation, abuse, misuse, misapplication, improper or lack of maintenance, negligence,
accident, normal deterioration (including wear and tear), or the use of improper parts or
improper repair.
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Purchaser’s remedies are limited to replacement or repair of non-conforming materials in ac-
cordance with the written warranty. This warranty does not include costs for transportation,
costs for removal or reinstallation of equipment or labor for repairs or replacement made in
the field.

Y %
R LB B
O N

Y%
N

7 7 <7
B
O O O
7
¥
N

Y

Y

O
x>

O

If any sample was shown to the buyer, such sample was used merely to illustrate the general
type and quality of the product, and not to represent that the equipment would necessarily
conform to the sample.
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This is the only warranty given by the seller, and such warranty is only given to buyers for
commercial or industrial purposes. This warranty is not enforceable until the invoice(s) is
paid in full.
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THE FOREGOING SHALL CONSTITUTE SATS’S ENTIRE LIABILITY AND YOUR EXCLU-
SIVE REMEDY. IN NO EVENT SHALL SATS BE LIABLE FOR ANY DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES, INCLUDING
LOST PROFITS (EVEN IF ADVISED OF THE POSSIBILITY THEREOF) ARISING IN ANY
WAY OUT OF THE INSTALLATION, USE OR MAINTENANCE OF THE EQUIPMENT. THIS
WARRANTY ISINLIEUOFALLOTHER WARRANTIES, EXPRESS ORIMPLIED, INCLUDING
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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2.0 DESCRIPTION

C6000 controllers are equipped with software to meet
the needs and technical requirements of the applica-
tion. The controller is factory pre-programmed and
therefore, most applications require no field setup.
The setpoints and ranges are easily adjusted from the
user interface. The program and operating param-
eters are permanentrly stored on FLASH MEMORY
in case of a power failure. A complete air condition-
ing system consisting of multiple A/C units may be
controlled and monitored via the C6000 controller.

21 Capabilities and Features

® Input/Output Monitoring Status

® Full Integrated Control of Temperature and
Humidity Levels

®  Multi-unit Control and Remote Communication
with Building Management Systems

® Optional Remote Mounting to a Wall or Control
Panel.

2.21 Controlling Multiple A/C Units

2.2 General Design

The controller includes a main printed circuit board
with voltage processing unit. The following functional
components are provided with the C6000 controller:

® Microprocessor for controlling and monitoring the
A/C unit.

* RS485 interface for building management system,
(BMS), options and for connecting decentralized
I/O boards.

® Serial PC/RS232 printer interface.

® Controller handshake for linking a supervisor
(second controller).

® Backlit LCD display and LED’s for monitoring
operating conditions of the controller (A/C unit).

® Buttons for operating the controller

® Various plug connections

As a standard feature for controlling multiple A/C units, a master A/C may be fitted with a C6000 controller, and
each additional A/C module may be fitted with an 1/0O board. The I/O board is equipped with a separate power
supply. The controller and I/O board(s) are connected together via a RS485 bus. Figure 1 shows the basic
configuration for a 3 module air conditioning system as an example. Up to 6 A/C modules may be controlled by

a single C6000 controller.

A/C Module

Voltage Supply

U

A/C Module

Voltage Supply

< <———>{ 6000 Controller
1/0 Board 1/0 Board 1/0 Board

A/C Module

Voltage Supply

U

Figure 1- Multiple A/C Units

2.2.2 Supervisor Controller

The air conditioning system may also be equipped
with an additional controller (supervisor). If the mas-
ter controller fails, the supervisor takes over control
and monitoring functions of the complete air condi-
tioning system.

2.2.3 Expansion I/O board

The expansion I/O board enables the A/C unit to be
equipped with further options.

(©July, 2008)
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2.24 Remote Display

As an option, the controller may be factory supplied
for remote mounting. The remote mounted controller
is designed to be located directly on a wall or a con-
trol panel. Install the unit in a secure location where
it cannot be tampered with. Refer to the installation
drawing sent in the data package with your unit for
the dimensions and mounting layout.

23 Operator Interface

C6000 Operation & Maintenance Manual

A six-conductor cable harness is provided for inter-
connect wiring. Additional control conductors may be
required depending on the options purchased with
the equipment. It is important to identify the options
that were purchased with the unit in order to confirm
which field connections are required. Refer to the
electrical drawing supplied with your unit for details
on interconnecting field wiring.

The C6000 controller is typically installed in the control section of the A/C unit and is accessed from the front of
the unit. Figure 2 depicts the layout of the controller display panel and the location and description of the inter-

face buttons.

| — C6000 Controller

1/

\

Audible Indicator

TR control Service

725°F @
40 %RH

< > = Selector Buttons

12:45 C . OK = Enter Button

Reset = Reset Button
Sl LED = Alarm

LED = On/Off

® = On/Off Switch

Display

Figure 2- Controller Display Panel

Selector Button- Select menus and change

parameters.

Enter Button- Accept function/parameter

selections.

Reset Button- Accept function/parameter

On/Off LED- Illluminates when A/C unit is
switched on and operating.
On/Off Switch- Turns A/C unit on and off.

Audible Indicator- Audible Alarm.

. Display- Shows data, operating
selections. conditions and status
Alarm LED- Illuminates in event of an alarm. information.
2.0 (©July, 2008)
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2.4 Initial Starting Instructions

1. Before applying power to the unit ensure the operating voltage is correct as shown in the electrical drawing
provided with your unit. Verify all wiring connections are correct and that all electrical connections are tight.

2. Apply power to the unit. The “Start-up Window” is displayed (shown in Section 2.5.1), and the controller goes
through an internal initialization period (approximately 10 seconds). Once the initialization period is over, the
“Standard Window” (shown below) is displayed showing the current temperature and humidity conditions.

3. Press the “On/Off” button (shown in Figure 2). The LED next to the button illuminates green indicating the unit
is turned on.

4. The A/C unit(s) will begin operating in accordance with the configuration and setpoint parameters as pro-
grammed by SATS. If Cooling, Heating, Humidification or Dehumidification are called for, a status symbol ap-
pears in the bottom of the display window indicating which functions are currently operating. A C6000 Factory
Set-up Sheet, provided with your unit, shows all the programmed settings. The initial temperature and humidity
setpoints may be viewed and changed in the Control > Temperature and Control > Humidity menu window
as described in Section 3.3 of this manual.

2.5 Operating The Controller

The controller is operated in three function levels (Info, Control and Service) which are shown in the menu line
of the display. The display windows are seleted from the Menu line using the “< >” selector buttons. Depending
on the configuration of the A/C unit, the controller only displays information that is applicable to that configura-
tion. Access to “Control” and “Service” function levels are are managed by a security protocol and requires

the use of a password to gain access. Once access is gained to the function level, you may access sub-menu
catagories using the “< >” selector buttons.

Menu line

Time
¢ Night operation
Day operation

Info Control/ Service 12:45

3
o Remote On/Off disabled

Status symbols

o Cooling o Remote On/Off enabled
Heatin

% g | Status display-

iy Humldlf.yl.ng‘ Displays the current room or

>y Dehumidifying ~—R % supply air temperature and

humidity.
Displays the operating

conditions of the A/C unit.
If the unit stops, the display shows the

This symbol appears together with the reason why.
:\: message “Service Required”. Contact

2. “On/Off" (T) button on the controller

1. Remote On/off
the SATS Product Support Group.
/ has stopped automatic operation
3. PC internal logic
—STOP—[=] CH

E EE‘— 4. Internal time switch (Day/night opera-
tion)

Figure 3- Controller Display Screen
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2.5.1 Info Menu

a7izl

nic

Grap

Actual /setp.
Module state
Day & Night
Runtime
Event—Log
Info

All set parameters and function modes of the A/C unit
can be called up in the Info menu by the operator.
This menu is basically only intended for displaying

all values and parameters. However, it is possible

to select and change parameters after entering a
password in the Info > Graphic > picture “change”
window and in the Info > Day & Night “change”
window.

2.5.2 Control Menu

return

12145
re

Humidity

Module functions
Day & Might
Preferences
Special functions

return

The parameters of the A/C unit such as specified
temperature, specified humidity and on/off switching
values of the individual components can be changed
and entered in the Control menu.

2.5.3 Service Menu

Manual oper.

return

The Service menu is used to configure the A/C unit
and should only be accessed by experienced cus-
tomer service staff.

You will find the following parameter settings in the
Service dialog windows:

S = Constant actuation (0 - 10V)
0 = Off
VA = 1-Single stage / 2-Two stage

0-99 = Degree of opening of a valve
- = Components not fitted

C6000 Operation & Maintenance Manual

2.6 Navigating Menus, Dialog Windows
and Parameter Fields

When the A/C unit is switched on, the Start-up Win-
dow appears on the display and then after a short
period, the Standard Window appears from which
you can enter all the sub menus and dialog windows
(see Section 3.1).

2.6.1 Start up window

C6000 V 2.32 .Compact DX

J‘Av%m’r Techriology Systems, e, =
— 4 uy W

MOD.: 1 2 3 4 5 6
B o X X
E X X

The start up window displays the version number

of the software and the type of the A/C unit being
controlled. The information in this window is needed
whenever contacting the factory for service. The con-
figuration of modules 1-6 (MOD) is also displayed.

B = Basic I/O board
E = Expansion I/O board

2.6.2 Selecting Menu Contents

Room #* ™ Menu
/B2°F @ Option
40 %RH

5 4 SA7S

You select the menu contents by highlighting the
desired catagory in the menu line (shown with a dark
background) using the “< >” selector buttons, and
then press the “OK” button.

Humidity

Module functions
Day & Might
Preferences
Special functions

[ Menu

Contents

v = Option selected
return
X = Components currently active.
The menu contents are then shown in the display.
2-4 (©July, 2008)
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2.6.3 Opening Dialog Windows

G 15 39
°F min. Setpoint max.
Room — CUEPAN:RUE-%
Sup.air - - - <
Water —- -- -- [ Dialog
Window
return

You open a dialog window by selecting an option
from the menu contents with the “< >” selector
buttons and then press the “OK” button. The dialog
window now appears on the display.

2.6.4 Selecting Modifiable Parameters

Setpoint max.
75,8 88
Sup.air - == ~
Water - -— -- Parameter
Field
return

Select the desired parameter field in the dialog win-
dow using the “< >” selector buttons to highlight the
field and press “OK”.

2.6.5 Changing Parameters

A L 11 36
" min. Setpoint max.
60 [salc 80|
- p— == .
Water - - - Frame

return

The parameter field is now provided with a frame
around it. Change the value shown using the “< >”
selector buttons. When you press “OK”, the revised
value is entered and the frame of the parameter field
disappears. You can then select other parameter
fields to change with the “< >” selector buttons.

3.0 MENU WINDOWS

3.1 Standard Window

OIlcontrol Service 12:45
Room W
2Z25°F =@
40 *%RH

B 4 SATS

The standard window is continuously displayed when
the A/C unit is operating. In the Standard Window
you can adjust the time, changeover between the
room and the supply air display, changeover from day
to night operation and lock or release Remote On/Off.

You may also access the three sub menus from this
window by scrolling through the menu catagories
(Info, Control and Service) using the “< >” selector
buttons. When the desired sub menu is highlighted
with a dark background, pressing the “OK” button
allows access to the display/dialog windows of that
menu.

You enter the Standard Window parameter fields by
pressing the “OK” button while “Info” is highlighted.
The word “more” appears in the bottom right corner
of the window.

Info Control Service 14 44

Room b 5
7Z5°F @
40 »RH

v

[more |

When the “>” selector button is pressed, you enter
the first dialog display of the Standard Window where
the first parameter field highlighted is “Room”.

B

OIEcControl Service 12:45
/
’20°F @
40 %RH
B SATS

(©July, 2008)
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NOTE

If you press the “OK” button instead, you enter
the “Info” menu which displays the “Info” menu
catagories (see Section 3.2).

You can change the display from showing room air
conditions to showing supply air conditions in this
window.

When the “OK” button is pressed, a frame appears
around the field to be changed.

OIEcControl Service 12:45 /Frame
|
*:
’20°F @
40 %RH
R SATS

You may change the display from “Room” to “Sup.
Air” sensor control with “< >” selector button.

NIl Control Service  12:45 | Change

Selection
£ 3
41 °F @
62 »AH

B % SATS

The change is accepted by pressing the “OK” button.

OTEControl Service  12:45 L Change
=~ Accepted

C6000 Operation & Maintenance Manual

The button operation is based on the same sequence
as just outlined.

You proceed to the following dialog field by using the
“>” selector button where you can change over from
day to night operation.

OTlControl Service 12:45 Day/Night
Room B3t
725 °F & | :#=Dayoperation
40 %RH ( = Night operation
B SATS

Day operation corresponds to operation at the initial
setpoint temperature. Night operation corresponds to
operation at the second setpoint. (See Section 3.3.4)

The final item which you can change in the Standard
Window is the “Time” field, which you can access us-
ing the “>” selector button and pressing “OK”.

Time
EIcControl Service =
Room *»:
’25°F @
40 %RH
R N SATS

The following can be adjusted in sequence using the
“< >” buttons:

*
?5%1?;: = press “OK”
vonth ........ IR
B 4 SATS .
press “OK
Using the “>” selector button you access the next )
dialog field in which you can enable/disable “Remote Day...en.
On/Off” switching. press “OK”
[ITEMControl Service 1z:e5 HOU wevrreeee H: 15
Remote PR
Room » t_/ On/Off press "OK
225 °F B
A0 %RH 3 = Enabled Minute .......... m
i = Disabled/
B 4 SATS Locked Out
3-2 (©July, 2008)
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INFO MENU

NOTE: The section numbers which appear in parenthesis above each window may be referenced in this manual
for a functional description of the window.

(Sect. 3.2) (Sect. 3.2.1) (Sect. 3.2.1.1)
a7i21 14 64 12145
ure J/Room xrature Room « » .
Actual /setp. Seip.air 258 . Select “change” to Modify
aul tat . i o
Day & Night. PN 218 || Temperature or Humidity
Runtime Humidity Room /f"\- 19890 Setpoints
Event—Log Beip.aie e 3 12 18 24 HOUR
Info retyrn return SETP. o z4g°c  (EETTchange
(Sect. 3.2.2) <k
I e Password Required
D;BEE‘WRIR Zg,S“F FoAPF V5H °F
iRTER - See Control Menu,
Section 3.3
ARALOGUE 7 ——
(Sect. 3.2.3) (Sect. 3.2.3.1)
u Modules 12
Coaling GE/CW valve - -
compressor 11
— | | Humidification X Drycooler - -
Dehumidific. Suctionvalue - -
return
(Sect. 3.2.4) (Sect. 3.2.3.2)
15:32 et —— 12145
no Select “change” to Modify E~heating °C
WE T5@ 2F = . . Hotgas reh. - -
—Ia aa0-r. — Day/Night Operating Pa- — |HWR—valve - -
20 rameters
* [Ghoinge) AT
= (Sect. 3.2.3.3)
ect. 3.2. : s 1zies |
(Sect. 3.2.5) Password Required —
Humidification 60 -
COMPRESSOR g 2 See Control Menu, Dehumidific. a -
Eﬁ:smma S g Section 3.3
FUMF 1 B a
FUMF 2 B a
HUMIDIFIER @ a return |
(Sect. 3.2.6)
(e 15151 | A
EH
s | Select “more” For |
34 —|  Additional Screens |
EH Y | as Applicable |
return Lo 1
(Sect. 3.2.7)
15:34
EOFTWARE: CEp@E Uz, 50 A-G/GE-CH
RELEASE :27. 06,2006
PRE-CODE: 1080 GEECEEEEEEOOEE
888 BODIEEEORER10D
EEL
sars
Figure 4- Info Menu Windows
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3.2 Info Menu

Various data and operating states of the individual
modules and components of the A/C unit are dis-
played in the Info menu. Certain parameters can be
changed in the Info menu with the use of a pass-
word.

a7zl

Actual./setp.
Module state

Day & Might
Runtime
Event—Log
Info

return

In this menu level you obtain information about the
room climate, about the A/C unit modules about the
day/night operation and about the unit run times.

3.2.1 Graphic Window (i >[Graphid)

14 @4

ture /Room
Bup.air
Water
Gutg.aly

Hurnidity Room

Baip.nlr

return

In this dialog window you select the desired informa-
tion, (v'= option selected), and call up the “picture”
display window. Not all combinations are possible.
Only the values which are provided with sensors can

be selected. Non-assigned values are shown in grey.

3.2.1.1 Picture Window (info > Graphic > [picture)

The temperature and/or air humidity of the last 24
hours are shown in this dialog window. The verti-
cal line identifies the current time. To the right of the
line yesterday is shown and left of the line today is
shown.

1Z2:45

ature Room

24890

/hh 12@8°C

3 12 18 24 HOUR &

[
SETF. oo zqp°c  [ENATOchange

The “change” option is only available when an indi-

vidual condition (Temperature or Humidity) is select-
ed in the previous dialog window. (v'= option select-
ed.) The outside air limit values cannot be changed.

C6000 Operation & Maintenance Manual

You can change the room temperature and air humid-
ity from this dialog window with the use of a pass-
word. The password and description of the “change”
dialog window can be found in the Control menu
Section 3.3 of this manual.

3.2.2 Actual/setp. Window (o >[Actualsetd)

SETP. CORE.
725 °F V5B °F F5B°F
SUP. AIR --
WATER --

494 W 458 W 450 %
SUF. ALR --
AHALOGUE 7 -—-—

This dialog window shows the current values of the
sensors connected to the I/O boards as well as the
setpoints entered in the controller. Furthermore,
the setpoints shifted by the controller (CORR.) are
displayed. These setpoints are due to the weekly
“Day/night” cycle program (see Section 3.2.4) or by
the sensor limitation control (see Section 3.4.2.1.2).
The shifted setpoints are priority setpoints.

3.2.3 Module State Window (info > Modue state)

Cooling
Heating
Humidification X
Dehumidific.

return

This dialog window displays how many modules your
A/C unit is comprised of. An "X” shows which function
of the module is currently active. An “S” indicates a
stand-by module.

3.2.31 COOling Window (info > Module state >[Cooling)

GE.-CW value
Compressor
Drycooler
Suctionvalve

1
1

[ X

The operating state of the components of the refriger-
ant circuit of each individual module is displayed in
this dialog window.

“0”= The component is currently off.
“1” = Asingle stage is currently active.

Component is not furnished.
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Info Menu (cont.)

3.2.3.2 Heating Window (info > Module state >[Healing)

4 H 12245
Modules 12
E-heating a -

Hotgas reh. - -
HWR—valve - -

If the individual modules of your A/C unit are
equipped with a heater, the operating state is dis-
played in this dialog window.

3.2.3.3 Humidity Window (info > Module state >[Humidificatior)

12145
odules 12

Humidification 60 -

Dehumidific. a -

If individual modules of your A/C unit are equipped
with a humidifier, the operating state of the humidi-
fier is displayed in this dialog window. In addition the
display indicates whether the dehumidification circuit
is switched on or off.

3.2.4 Day & Night Window (1o >[Day & Nighy

"12 ' 1 ' 24 mouR

change

The daily operating time, and the specified day and
night room temperature setpoints are shown on a
weekly basis in this dialog window.

You can change the operating schedule from this dia-
log window with the use of a password. After entering
the correct password, you have the ability to specify
the operating time or change one of the setpoints.
The password and description of the “Day & Night”
dialog window can be found in the Control menu
section 3.3 of this manual.

3.2.5 Runtime Window (it > Runfimd

HOURS

X

i
COMPRESSOR =]
FAM @
E-HEATIHG a
FUMF 1 a
PUMP 2 a
HUMIDIFIER a

[~ ]

The runtimes of the listed components of the A/C unit
are shown in hours in this dialog window. Additional
modules (M3 - 6) of the A/C unit are displayed by
selecting "more”. You go back to the Info menu by
selecting “return”.

3.2.6 Event Log Window  (info>[EventLog

TOTOTOTIDE
D)
LRl ST TN T TN T O
Ittt e |
weacncncnoncnoacnn| G
it b ponononen| O
ORIOE AT ] =

All alarm signals of the A/C unit are listed in this
dialog window. The signals contain the following in-
formation: Module, alarm report, day and time. This
window also displays when the unit was started and
stopped. Up to 20 event windows can be displayed
by selecting “more”. The alarm memory may be
erased by switching the power off then, simultanously
press and hold the “RESET” and “OK” buttons (until
the standard window is visible) while switching the
power back on.

3.2.7 Info Window  (info >infd

15:34

SOFTWARE: C&BEE UZ, 58 ACG-GE-CW
RELEASE :27.HBE&, ZEEE

FRG-CODE: 1080 BOO0G0EAGGEO0RAEQ0
BEE GEO0loQ0o0EE@lod
gEa

SA7S

In this window the software version and the date of
issue is displayed.

(©July, 2008)
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(Sect. 3.3)

Temperature

11:53

CONTROL MENU

Humidity

Day & Night
Preferences

Module functions

Special functions

return|

NOTE: The section numbers which appear
in parenthesis above each window may be
referenced in this manual for a functional

(Sect. 3.3.3)

Cooling
Heating

Humidification
Dehumidific.

Air
Default settings

return

(Sect. 3.3.1)
15 39
°F min. Setpoint max.
Room [ 75,8 1]
Sup.air - - -
Water - - -
description of the window.
return
(Sect. 3.3.2)
12145
#%RH min. Setpoint max.
15 48 68
Sup.air 18 - 75
return
(Sect. 3.3.4)

PB4 OF -

ch

P

18 ' zdHour

(Sect

Alarm tone
Alarm priority
Sensor ad just
“C / °F

Date format
Languages
Integral factor

ange
3.3.5)
12145
return

(Sect.

Ext. setpoint

3.3.6)

return

(Sect. 3.3.6.1)

return

(Sect. 3.3.5.1)

12145

Alarm priority
Sensor ad just
“C / °F

Date format
Languages
Integral factor

return

(Sect. 3.3.5.2)

Alarm
Supervisor operat.

return

(Sect. 3.3.5.3)

return

(Sect. 3.3.6.2)

return

(Sect. 3.3.5.4)

Figure 5- Control Menu Windows

123145
Alarm tone
Alarm priority
Sensor ad just
“Celsius
Date format
Languages
Integral factor return
(Sect. 3.3.5.2)
12:45
Alarm tone
Alarm priority
Sensor ad just
“C ~ °F dd-mm.~yy
Languages
Integral factor return

(Sect. 3.3.5.3)

12:45
Alarm
Alarm priority
Sensor ad just
“C /s °F

Date format

German
English

Integral factor return

(Sect. 3.3.5.4)

123145
Alarm tone
Alarm priority
Sensor ad just
“C S °F

Date format
Languages

return
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(Sect. 3.3.3.1)

Compressor
Suctionvalve

GE/CW wvalve
Drycooler
Pumps

return

CONTROL MENU (cont.)

(Sect. 3.3.3.2)

(Sect. 3.3.3.2.1)

12:45

E—heating

Hotgas reh.
HWR—valve

return

M1 M2

SETFOINT-R
[STORT TEMP. 1 ity
HYSTERESIS 83 a3
START TEMP. 2 36 45
HYSTERESIS 85 83

return

“RH
5
HYSTERESIS 3
a
a

START FROF.
GRACIEMT PR. 1

return

(Sect. 3.3.3.2.2)

M1

M2
SETFOINT- R
g -

STARTTEMP,
HYSTERESIS L

return

(Sect. 3.3.3.4)

“RH
]
HYSTERESIS ia

ETPOINT-"R

=
CEHUM. STOP 2 ALL MODULES

return

(Sect. 3.3.3.2.3)

M1 M2

SETRPOINT-"R
- -
HYSTERESIS - -
START PROP. - -

GRADIEMT FR.

return

(Sect. 3.3.3.5)

arviad

M1 Mz

SETFOINT+R
[STRRTTEMP.  [Rcielc)
SGEADIENT FR. 36 36

return

(Sect. 3.3.3.6)

12143

Default
All parameters will be
set to a default value!
YES

(Sect. 3.3.3.1.1)

12145
TORFR
M1 M2
SETPOINT+R
START TEMF. 1 BE]
START TEWF.Z L7 23
HYSTERESIS 13 13
return

(Sect. 3.3.3.1.2)

123145
SUETI
M1 M2
SETPOINT+R
STARTTEMP.  [RMNchd
GRADIEWT PR. A9 A9
return

(Sect. 3.3.3.1.3)

M1 M2

SETRPOINTHR
[STARTTEMP.  [chack]
GRAPIENT FR. 11 1.1

WATER TEMP. *°F
GE-OFF 7 73

3
DEHUMIDIFIC., 45 43

return

(Sect. 3.3.3.1.4)

(Sect. 3.3.3.1.4)

i 12:45

DRYCOOLER
M1 M2

WATER TEMP. *=F
[START _TEMP. 1 Lizgay)
START TEMF.Z 33 23
HYSTERESIS 36 36
STAGE 1 1

more  return

: i 12145
DRYCOOLER
SUMMER-WINTER
OUTSIDE TEMP
STARTTEME.  EI8
HYSTERESIS 32
return

(Sect. 3.3.3.1.5)

SETPOIMT+"R
[STORTTEMP. __likd
HYSTERESIS a5
MODULSPAMHING 1

return

CAUTION /\

Do not enter “YES” to re-set the pro-
grammed values unless you intend to re-
program all of the parameters and control

setpoints.

(©July, 2008)
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3.3 Control Menu

In the Control menu you have the ability to change
various parameters and operating states of individual
modules and components of the A/C unit.

NOTE
A password is required to enter this menu.

The password is entered using the selector buttons
and the confirmation buttons.

The password is:

“<”  (Left selector button)
“OK” (OK button)

“>” (Right selector button)

The first two buttons, (“<” and “OK”), must be
pressed in sequence, at the same time the flashing
colon in the time field is visible.

Colon
Info [Control FETNIR 11@2
£ 3
F @
RH
—STOP— SA7S

NOTE
You may only enter the control menu after en-
tering the correct password.

11:53
Temperature
Humidity
todule functions
Day & Night
Preferences
Special functions

return

3.3.1 Temperature Window (Control > Femperaturd)

°F min. Setpoint max.
Room (2] 75,0 sa
Sup.air - -
Water - - -

return

Limit values and setpoints for the required room
temperature are to be entered in this dialog window.
The specified limits can be changed for the room or
supply air temperature and the water temperature.

NOTE

The “min” & “max” values are the alarm set-
points.

C6000 Operation & Maintenance Manual

3.3.2 Humidity Window  (Contro/> Humidity)

¥RH min. Setpoint max.

CICmEs 48 66

Sup.air 18 - 79
return

The limit values and setpoints for the required room
humidity are to be entered in this dialog window.
Specified limit values can be changed for the sup-
ply air humidity if an optional supply air sensor is
installed.

3.3.3 Module Functions Windows (Control >[Module functions)

Heating
Humidification

Dehumidific.
Air
Default settings

return

Further dialog windows can be selected from this
menu in which the limit parameters and setpoint
parameters of the individual A/C unit components can
be changed.

WARNING A

Changing the Control > Module functions
menu parameters requires a high level of ex-
perience with refrigeration systems and must
be performed by an authorized refrigeration
mechanic or air conditioning technician.

3.3.3.1 Cooling (Control > Modute functions > Cooling

Compressor
Suctionvalve

GE-CW wvalve
Drycooler
Pumps

return

Dialog windows applicable to your unit may be se-
lected from the “Cooling” menu window.

3-8
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Control Menu (cont.)

3.3.3.11

Compressor (Control > Module functions > Cooling >

M1 Mz

SETPOIMT+R
STHRT TEMP. 1 JRcapec]
START TEMP. 2 L7 23
HYSTERESIS 12 13

return

The start temperature for the first and second com-
pressor (for compressor based units only) can be
adjusted in this dialog window. The hysteresis can be
adjusted in °Rankine, (°R). The setpoint temperature
is established in the Control > Temperature dialog
window, (Section 3.3.1).

NOTE
AT. °Fahrenheit = AT. °Rankine

NOTE
All “Start Temp.” and “Hysterysis” values are en-
tered as the difference from the setpoint in °R.

Hysteresis: Margin between the cut-in and cut-out point.

Using the compressor  On
as the example. L

A\
Off » Temp.

»
-} -

Hysteresis

i (Control > Module functions > Cooling >
3.3.3.1.2 Suction Valve

b : 12:45
SUCTIOHUALLE
il

1 M2

SETPOINT+R
STARTTEMP. B8 8.7
GRADIEMT FR. 83 8%

return

If your A/C unit is fitted with a suction valve you can
adjust the start temperature (suction valve opens) and
the gradient of the suction valve in this dialog field.

Gradient: Increase in the valve opening depending

on temperature.
A

100%

0% /

»
'

» Temp.

<

Gradient

(Control > Module functions > Cooling >

GE/CW Valve,

] 12:45

3.3.3.1.3 GE/CW Valve

i
GE~CW UALUE

M1 Mz

SETPOINT+R
STHRTTEMF. Bz 8%
GRADIENT FR. 11 1.1
WATER TEMP. *=F
GE-OFF 7373
DEHUMIDIFIC, 45 45

return

If your A/C unit is equipped with a GE/CW control
valve, you can determine the start temperature and
the proportional gradient of the GE/CW control valve.
“GE-OFF” closes the GE/CW valve when the entered
temperature is exceeded. GE dehumidification ends
when the entered temperature is not achieved since
the GE/CW valve is completely closed. Also refer

to Section 4.2 for a detailed description of GE/CW
system operation.

(Control > Module functions > Cooling

>[Drycooler]

3.3.3.1.4 Drycooler

If your A/C unit is connected to a Drycooler, you can
determine the cut-in temperature of the Drycooler for
winter and summer operation, the hysteresis and the
stages for the sequential shifting in this dialog win-
dow. A detailed description of the Drycooler opera-
tion can be found in Section 4.3.

b : 12:45

DREYCOOLER
M1 M2

WATER TEMF. ©°F
STRRT TENMP. | [l
START TEMP. 2 93 95
HYSTERESIS 36 36
STAGE 11

more | return

To access the next “Drycooler” submenu, select
“more” and press “OK”.

DRYCOO
SUMMER-WINTER

OUTSIDE TEMP.
STHRETTEMF, &1
HYSTERESIS 22

return

Here you can set the shift point for the summer/win-
ter operation. When above the adjusted outside tem-
perature, the unit is shifted to the summer operation
mode. When below the adjusted outside tempera-
ture, the unit functions in the winter operation mode.

(©July, 2008)
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Control Menu (cont.)

3.3.3.1.5 Pumps (Control > Module functions >[Pumps)

BF:aa

HYSTERESIS @5
MODULSPANHING 1

return

The optional glycol pump (2 maximum) is only in-
stalled in the pump section on GE units. You deter-
mine the cut-in temperature and the hysteresis of
the glycol pump in this dialog window. Additionally
you can adjust whether a sequencing based on time
and malfunction between pumps of different modules
shall take place (1= yes, 0= no). See Section 4.2.1.

3.3.3.2 Heating Windows (Control > Module functions >[Heating)

12:435

Hotgas reh.
HWR—valve

return

3.3.3.21

E-Heating (Control > Module functions > Heating.

>[E-heating

E-HERTIH

M1 MZ

SETFOINT-R
[STHET TENMP. L ity
HYSTERESIS 83 89
START TEMF. 2 36 45
HYSTERESIS 8,3 83

return

You can establish the start temperature and the hys-
teresis for the optional electrical heaters installed in
your A/C unit in this dialog window.

33322 Hot Gas Reheat (Control > Module functions >

Heating >

"Mt omez
SETPOINT-R

STARTTENF.  [ICH

HYSTERESIS 1.8 -

return

If your A/C unit is equipped with a refrigerant heater
you can establish the start temperature and the hys-
teresis.

3.3.3.2.3

HWR-Valve (Control > Module functions > Heating >

Bri@l

M1 M2

SETFOINT-"R
STHRTTEMF. - -
HYSTERESIS - -
START PROP. - -
GRADIEWT PR. - -

return

If your A/C unit is equipped with a LPHW heater, you
can control this via the proportional LPHW valve.
The upper two lines relate to an On/off-valve, the two
lines below refer to a proportional valve. By “Start
temp.” or “Start prop.” you set the temperature differ-
ence to the setpoint, at which the valve shall open.

Setpoint
Hysteresis
onorr A
Valve
Start temp.
Setpoint
Prop. 100%
Valve \
|Gradient pr.

Start prop.

3.3.3.3 Humidifcation Window (Control > Module functions >

12:45
HUMILIFI

M1l M2

“RH
[STHRTHUN. I
HYSTERESIS 5
START FROF. B
GRADIENT FR. 18

return

If your A/C unit is equipped with an optional hu-
midifier, you have the ability in this dialog window to
determine the start humidity, the hysteresis of the
humidifier as well as the starting humidity and the
gradient of the associated proportioning valve.

NOTE

All start values are entered as the difference
from the setpoint in % Relative Humidity.

(©July, 2008)
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Control Menu (cont.)

idifi i (Control > Module functions >
3.3.3.4 Dehumidific. Window

) 15 5&

i
DEHUMIDIFIC.
M1

WRH
[STHRETHUM, ]

HYSTERESIS 1@
SETPOINT-°R

9 ALL MODULES

DEHUM. STOP

return

You can define the start point of the dehumidifying
circuit as well as the hysteresis in this dialog win-
dow. If the humidity exceeds the entered value, the
solenoid valve upstream of the evaporator closes and
humidity is removed from the air flowing through.

NOTE

“Dehumid. Stop” function. If the temperature drops
below the setpoint temperature by 3° when dehumidi-
fying, dehumidification is interrupted with a hysteresis
of 2°Rankine.

3.3.3.5 Air Window

(Control > Module functions >[Air)

FAH

STHRTTEMF.

MIMIMLUM
MARTHUM

GRADIENT FR.

3 ) 15:58

M1

SETFOINT+"R
k=]
36
7e
i@

return

This window is only relevant if the A/C unit is
equipped with a speed controlled fan. The fan speed
is modified by means of a frequency converter. Here
you adjust the start temperature for the frequency
converter to energize the fan. By the gradient you
can set the range in which the fan reaches its maxi-
mum speed.

3.3.3.6 Default Settings Window  (Control > Module functions

> Default seftings,
CAUTION A

Do not enter “YES” to re-set the programmed
values unless you intend to re-program all the
control parameters and setpoints.

12:45

Default settings
All parameters will be
set to a default value!

ves I

If you select “YES” in this dialog window, all the set
control parameters of the A/C unit are re-set to the

basic settings established at the factory. The default
settings can be found in Section 4.10.

The same effect is achieved by switching off the volt-
age and then simultaneously pressing the “ON/OFF”
button and the “RESET” button (until the standard
window is visible) while switching the voltage back on
again.

3.3.4 Day & Night Window (control >[pay & Night]

The operating time and the room temperature set-
point are displayed in this dialog field. The A/C unit
then works in a weekly cycle according to the set
values.

" 24 HOUR

P S

change

If you select “change” you have the ability to es-
tablish the operating time and the setpoint of room
temperature.

Thick line (—): setpoint, day operation
Dashed line (-----): 2nd setpoint, night operation
No line ( ): A/C unit off; © appears in the display

——— 75 °F —=| After going through the days “Mon”
== to “Sun”, you enter the field where
you can change the second setpoint.

3.3.5 Preferences Window (Control > Preferences)

Further dialog windows can be selected in this menu,
in which the values shown can be changed.

12345
Alarm tone
Alarm priority
Sensor ad just
°C / °F

Date format

Languages
Integral factor

return

(©July, 2008)
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3.3.5.1 Alarm Tone Window
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Control Menu (cont.)

(Control > Preferences >

3.3.54

°C/°F Window

(Control > Preferences >[°C/°F)

12:45

Alarm priority
Sensor ad just
“C ~ °F

Date format
Languages

Integral factor return

You can adjust the volume of the alarm tone in this
dialog window.

(Control > Preferences >

3.3.5.2 Alarm priority Window >F

Alarm text C/S Priority
[ 1]

Supervisor operat.

return

You can assign the alarm signals to the alarm relay

in this dialog window. External alarm signal systems
can be connected to the alarm relay. Depending on
the unit type, up to 10 BMS messages per module are
available from alarm relays (here called “Priority”).

Alarm relay 1 can not be reconfigured. It is reserved
for the common alarm. In the headline “Alarm text/
Priority”, the alarm origin is defined as either C/S
(Controller/Supervisor) or the module number 1 to 6.

For further information about BMS alarm assign-
ments see Section 4.6.

Alarm Relay Assignment
Module 1 2 3 4 5 6
Basic I/0-Board |1-2 |11-12|21-22|31-32(41-42|51-52

Expansion-1/O  |3-10[13-20|23-30|33-40(43-50{53-60
Board

(Control > Preferences >

3.3.5.3 Sensor Adjust Window

You can have the actual values of the connected sen-
sors displayed in this dialog window and compared
with the values of external measuring devices. The
measured values displayed can be adjusted here.
The difference to the actual measured value is dis-
played as an offset.

12:45

Alarm tone
Alarm priority
Sensor ad just
“Celsius

“Fahrenheit

return

Date format
Languages
Integral factor

The temperature display of all dialog windows can be
changed to °C or °F in this dialog window.

(Control > Preferences >[Date format

3.3.5.5 Date Format Window

12:45

Alarm tone
Alarm priority
Sensor ad just
dd.“mm.“yy

1| mm./dd./yy

Languages
Integral factor

The date display can be changed over to dd/mm/yy
or mm/dd/yy in this dialog window.

return

(Control > Preferences >|Languages]

3.3.5.6 Languages Window

12:453

German

English

Alarm tone
Alarm priority
Sensor ad just
“C / °F

Integral factor return

You can select the language in which the messages
are displayed in the dialog windows in this dialog
window. The illustration only shows a selection of
possible languages.

(Control > Preferences >

Integral factor)

12145

3.3.5.7 Integral Factor Window

Alarm
Alarm priority
Sensor ad just
“C / °F

Date format
Languages

return

In this window you can set the I-proportion of the
Pl-controller. In this case there is a fixed setpoint Sfix
(adjusted in the Control > Temperature menu) and
a variable setpoint Svar, which is recalculated every
5 minutes and which is decisive for the control. This
variable setpoint is calculated by adding the setpoint
alteration “dS” to the previous setpoint. Svar = Sprev.
+ dS with dS = (Sfix - actual value ) x Integral factor.

3-12
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Control Menu (cont.)

The values for the integral factor can be varied be-
tween 0 an 80%. A low value should be used to start
with in order to prevent the control system from oscil-

Actual value

ds \/

5 min. Time

lating. It is recommended that this value be increased
in 10% steps to find out the limit of safe control.

3 . . . (Contral>
3.3.6 Special Functions Window (Contol>

Phase

Ext. setpoint

return

Further dialog windows with special functions (de-
pending on special software versions) can be dis-
played in this menu.

3.3.6.1 Phase Window (Control > Special functions >[Phase€)

Unit

Module

return

In this window you can select whether the entire unit
or just one module shall be switched off in case of a
phase failure or a wrong phase rotation.

3.3.6.2 Ext. Setpoint Window (Control > &

return

In this menu you can choose whether the setpoint
shall be given externally. This can be individually ad-
justed for temperature and humidity by selecting “1”.
Selecting “0” disables the external setpoint.

If the external setpoint simulation for temperature in
the Control > Special functions > Ext. setpoint
menu is enabled, a setpoint simulator (e.g. poten-
tiometer) must be connected to analog input 6 (Ain
6). This can simulate either the voltage 0 - 10 V or
the current 0 - 20 mA at the input. In the Service>
Equipment>Sensor>extra menu (previously “Out-
side Air’), a sensor type must be configured.

If the external setpoint simulation for humidity in the
Control > Special functions > Ext. setpoint menu
is enabled, a setpoint simulator must be connected
to the analog input 7 (e.g. potentiometer). This can
simulate either the voltage 0 - 10 V or the current 0
- 20 mA at the input. In the Service > Equipment >
sensor > extra menu (previously “ANALOG 7”), a
sensor type must be configured.

(©July, 2008)
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(Sect. 3.4)

16:34

SERVICE MENU

NOTE: The section numbers which appear in parenthesis above each window may be referenced in this manual
for a functional description of the window.

(Sect. 3.4.1)

12:45
odules

Cooling

Heating

Gen. settings

Data
Manual oper.

return

(Sect. 3.4.4)

Humidity
Air
Sensor

return

(Sect. 3.4.3)

Alarm history

service data

Statistics
Printdata

return

(Sect. 3.4.4.1)

1z:43

Cooling
Heating
Humidity

Air

return

return

3.4.4.2)

12:45

GE-CW UALUE -
GELYCOLFPUMP -
DRYCOOLER -

return

(Sect. 3.4.4.3)

HEATIH

M1 M2

E-HEATIHG 2 -
HOTGAS REH. - -
HWFR HERTIHG il -

return

(Sect. 3.4.44)

12:45

HOMICT

M1 Mz
[HUMTDIFIER _ J:EE
DEHUMIDIFIC., 1 -

return

(Sect. 3.4.4.5)
12145
AIR

M1 Mz
[FaH SR
LOUYER - -

return

(Sect. 3.4.3.1)

(Sect. 3.4.3.1)

return

a
@ |
Module a
Module L
return
(Sect. 3.4.3.2)
12145
G1.87. 12:43
G167, 12145
G167 12:45
G187, 12145
Gl.E7. 12148
Bl.E7. 12144
G167, 12144
Gl.G7. 12144
Gl.E7. 12144
ILURE G167, 12144
return more
(Sect. 3.4.3.3)
12145
month
Service intervall HI
Service done
Last service 1.7, 20086
return

(Sect. 3.4.3.4)

Make a

Print intervall

Temp. data a
Alarm history a
Parameters a
Runtime a

(Sect. 3.4.3.5)
12145
min J
Printout of :

return

Figure 6- Service Menu Windows
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SERVICE MENU (cont.)

(Sect. 3.4.1.1)

Modules -

return

(Sect. 3.4.1.2)

12:45

(Sect. 3.4.2) (Sect. 3.4.2.1) (Sect. 3.4.2.1.1)

12:45

Control

SUCTIONURLUES Time delay Sup.air
| | GE-cu uALUE & B Function ] Room, supply air lim
GLYCOLFUMP @ @ | Interfaces T Supply air, room lim
DRYCOOLER @ @ Options text
return Sequencing
return return
(Sect. 3.4.1.3)
12145 (Sect. 3.4.2.1.2)
HEATIHG TS o i
M1 M2
[E-HEATIHG i)
HOTGAS REH. @ &
| | [HUR _HERTING @& @ L |
return
(Sect. 3.4.1.4) return
12145
AURTBITY T (Sect. 3.4.2.2) (Sect. 3.4.2.2)
HUMTDIFTER R i 12:42 . 12:43
> >
| || coNpucTIvITY G @ Seconds Seconds
DEHUMIDIFIC. 1 @ ] Compressor hold  JEeEl:]
Module 2 : 68
| |Stage H- T 98
return Temp..~humidit.al. : 48 Winter start ;188
All alarms :a
(Sect. 3.4.1.5)
e more return return
12145
AIR
_— (Sect. 3.4.2.3)
Loouer TR
return
(Sect. 3.4.1.6)
return
[Ro0M TEMP. _ [cBi]
SUP. TEMP. S1 @
WATER TEMF. @ &
— | oUTSIDE AIR 8 B8
ROOM HUM, 52 @
SUF. HUM, Sz @
ANALOGUE 7 @ @ |
return
return
(Sect. 3.4.2.5)
. alarm 1
Aux. alarm 2 UPS—Alarm
I~ | [Aux. alarm 3 Aux. alarm 3
Aux. alarm 4 Aux. alarm 4
return
(Sect. 3.4.2.6) (Sect. 3.4.2.6)
H @724 SinifilEiimiiin A7:24
Gen. settings
a St—By min Temp a
] St—By max Temp : ]
| a | |[cw priority
a
more return return

(©July, 2008) 3-15

| or——
Air Technology Systems, Inc.




3.4 Service Menu

In the Service menu you have the ability to change
the configuration of the A/C unit. Additionally, you can
change the settings for the types of control and other
parameters, as well as scan further data and oper-
ate the A/C unit in the manual operation level without
having to use the controller as a control unit.

Alarm signals do not appear in the Service level

in the dialog window. Alarms are only indicated by
means of an audible signal and the alarm LED. If you
want to know which alarm has occurred, you must
return to the main menu.

When you are in the Service level, control of the A/C
unit is continued. The module which you control in
manual operation is taken out of the control of the
system controller only when in manual operation.

NOT
A password is required to enter this menu.

The password is entered using the selector buttons
and the confirmation buttons.

The password is:
> (Right selector button)
“OK” (OK button)
“<” (Left selector button)

The first two buttons, (“>“ and “OK”), must be
pressed in sequence, at the same time the flashing
colon in the time field is visible.

Info Control TN 1 <()Fs

Colon

b )

You enter the “Service” level only after entering the
correct password.

Equi

Gen. settings
Data
Manual oper.

return

3.

C6000 Operation & Maintenance Manual

4.1 Equipment Window  (service >Equipment)
12145
Modules
Cooling
Heating

Humidity
Air
Sensor

return

The equipment of the A/C unit is divided up into six
areas. In this dialog window you select the area in
which you wish to configure the unit.

3.

41.1 Modules Window (sewice > Equipment >[Wodules)

Modules

return

You enter the number of the modules (1-6) which are
to be controlled in this dialog window. If you enter
more modules than are actually present, the “Trans-
mission error” alarm appears.

(2

3.

NOTE

The applicable values for the equipment of the
modules have the following significance:

= Not furnished

= 1 or 1st stage

= 2 or 2nd stage

= Components are controlled proportionally

4.1.2 Cooling Window

(Service > Equipment >[Cooling]

COMPRESSOR

1
SUCTIOHUALUE @ @
GE<CW UALVE @ @
GLYCOLPUMP 8 @
DRYCOOLER 6 @

return

In this window you specify which module is equipped
with a suction valve, with a GE/CW valve, with a
glycol pump and with a dry cooler. With the compres-
sor you can choose between “-” (no compressor =
CW version) “1” and “2” for the 2nd compressor. The
suction valve is actuated analogically, the control is
(S) constant. Dry coolers can be configured from 0

- 4 stages. “0” means no dry cooler is furnished.
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Service Menu (cont.)

3.4.1.3 Heating Window  (service > Equipment >[Heating|

12245
HEATIHG
M1 Mz

[E_HERTING )
HOTGAS REH. @ @
HWR HEATING & @

return

In this window you specify which module is equipped
with an electrical heater, with a hot gas heater and
with a LPHW heater. With the electric heater you can
also choose “2” for the 2-stage electrical heater. The
valve for the LPHW heater is actuated analogically,
the control is (S) constant.

3414 Humidity Window (Service > Equipment >[Humidity)

12245
HUMIDITY
M1 Mz

[HUMIDIF LER R
COMDUCTIVITY B 8
DEHUMIDIFIC. 1 @

return

In this window you specify which module is equipped
with a humidifier (steam humidifier or ultrasonic),
with a conductivity measuring instrument (for ultra-
sonic only) and with a dehumidifying valve. With the
humidifier you can choose between constant control
(S) and 2-point control (1) depending on the actual
equipment used with your unit.

3.4.1.5 Air Window (Service > Equipment >[Air]

12:435

AIR
Mi M2

LouuER SR

return

In this window you select which module is equipped
with a louver. This activates a time delay for the mod-
ule to allow the louver to fully open before the blower
starts. (The controller does not operate the louver, it
just builds in a time delay before the blower is called
to operate.)

3.4.1.6 Sensor Window  (Service > Equipment >[Senso]

B 12145
SENSOR M1 Mz
[ROOM_TEMP. RN
SUP. TEMF. 51 @
WATER TEMF. @ @
OUTSIDE AIR @ @
ROOM HUM. 52 @
SUP. HUM. 52 @
AMALOGUE 7 @ @
return

In this window you select the type of sensor in each
module. If there is more than one sensor of the same
kind, a mean value is calculated. In the main menu
only the mean value is displayed. e.g.: Room tem-
perature sensor in module 1, 2, 3

Value = Sensor 1 + Sensor 2 + Sensor 3
3

Only the mean value is used for the control.

Sensor Values

Sensor type * | Output Range
S1 Current 4 ...20mA 0...50.0
S2 Current 4 ...20mA 0...100.0
S3 Current 4 ...20mA 0...50.0
S4 Current 4 ...20 mA 0...100.0 **
S5 Voltage 0..10V 0..50.0
S6 Voltage 0..10V 0...100.0
H *** N/A 0 0

* Ensure the jumpers on the I/0 board are in the correct
position!

** Exception: -58 ... 122°F for outside temperature and
water temperature.

*** H- |s entered in Service > Equipment > Sensor > Wa-

ter Temp for using On/Off control on water/glycol systems.
(Voids sensor when proportional control is not used.)

The transmitted values of the different sensors can
be read in the Info > Actual/Setp. menu.

(©July, 2008)

3-17

STULZ

| or——
Air Technology Systems, Inc.



C6000 Operation & Maintenance Manual

Service Menu (cont.)

3.4.2 Gen. Settings Window  (service >[Gen. seffings

Time delay

Function
Interfaces
Options text
Sequencing

return

You select the area in which you wish to make further
adjustments in this dialog window. The “Function”
sub-menu is important during supervisor operation,
for the configuration of stand-by modules and for the
selection of the sequencing module.

3.4.2.1 Control Window (Service > Gen. settings >[Control)

Payameisrs

return

You can select the type of control in this dialog win-
dow. The parameters field can only be selected if you
have selected “Room, supply air lim” or “Supply air,
room lim” types of control below.

3.4.211

(Service > Gen. settings > Control >

Control type

Changing values using the example of the Service >
Equipment > Control type dialog window.

After you have pressed the “OK” button, the following
dialog window appears.

Supply air, room lim

Using the “< >” button you can now choose between
the types of control. The actual values displayed
change corresponding to the above selected type of
control (Room or Sup. Air). Pressing “OK” accepts
the entry and returns you again to the “Gen settings”
dialog window.

Room Air Control is the standard type of control.
The temperature/humidity sensor is placed in the

return air intake and the C6000 controls operation
in accordance with the setpoints set in the Control
> Temperature or Control > Humidity menu. The
limit values of the room air are monitored.

With Supply Air Control, an external T/H sen-

sor is required. Control takes place for the room in
accordance with setpoints for the supply air, set in
the Control > Temperature or Control > Humidity
menu. The limit values of the supply air are moni-
tored.

3.4.2.1.2 Parameters

(Service > Gen. settings > Control >

Parameters)
You can select the “Parameters” field and then ac-
cess the dialog window shown below for the “Room,
supply air limited” and “Supply air, room limited”
types of control.

return

The start temperature can be adjusted between

0 and 72°R, in 0.2°R stages. The gradient can be
adjusted between 0 and 2 in increments of 0.1. The
start humidity can be adjusted between 0 and 90% in
1% increments.

With “Room, supply air lim”, (room control with
supply air limitation), control takes place via the
T/H sensor in the return air intake and a second T/H
sensor in the supply air. Primarily control takes place
as for room air control. An increase in setpoint occurs
only if the measured supply air temperature exceeds
a specific temperature which is set in the Service

> Gen. settings > Control > Parameters > Start
temp. menu. The extent of the setpoint increase is

3-18

(©July, 2008)

STULZ

I
Air Technology Systems, Inc.



C6000 Operation & Maintenance Manual

Service Menu (cont.)

determined by a factor which is entered as a gradient
in the Service > Control > Parameters > Gradient
menu. The relationship according to which this hap-
pens is illustrated by the following graph:

If the room temperature exceeds the start tempera-
ture entered, the temperature setpoint is reduced. If
the room humidity drops below the starting humidity
entered, the humidity setpoint is increased.

Setpoint

A

Temperature

705 oo .
70

' ooy
T T T -

59 60 61 62 TFF

Actual Value

A steep gradient drastically corrects the failure to
meet the supply air temperature, but has the risk that
the control circuit starts to hunt.

With humidity control the setpoint shift takes place in

the opposite direction. If the adjusted starting humid-
ity is exceeded by the measured supply air humidity,

the setpoint is reduced. You can also enter a gradient
factor for this. The relationship is shown in the follow-
ing graph:

Setpoint

|

Hurridity

50 |
49

T T T -
68 70 72 74 Hi%
Actual Value

New setpoint = old setpoint + gradient e (start
value - actual value)

Example (temperature): 70.5 =70 + 0.5 x (61 - 60)
Example (humidity): 49 =50 + 0.5 x (70 - 72)

The “Supply air, room lim”, (supply air control with
room air limitation), is based on the same control
principle as the “Room, supply air lim.” air control
only, here the setpoint shift works in the opposite di-
rection on the basis that the supply air is colder than
the return air.

Return Air

T/H Sensor For
Return Air

T/H Sensor For
Room Air

Height > 60"

Supply Air

T/H Sensor For
Supply Air

Figure 7- Temperature/Humidity Sensor Location

The limit values of all four input variables are moni-
tored for room air control with supply air limitation
and for supply air control with room air limitation.

- Room air temperature
- Room humidity

- Supply air temperature
- Supply air humidity

The sensor should be positioned depending on the
space available, the thermal load distribution and the
selected type of control.

(©July, 2008)
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Service Menu (cont.)

3.4.2.2 Time Delay Window (Service > Gen. settings >

In this window you can adjust the time delays, with which
certain components are switched on or when alarms are
displayed. This prevents all the equipment from being
switched on at the same time causing in a mains overload.

/ more | return

Highlight the word “more” and press “OK” to access the ad-
ditional “Time delay” dialog window shown next.

Winter start : 188

return

3.4.2.21 Unit

The switch-on delay for the system can be adjusted
in 10 second increments between 0 and 2,550 sec-
onds (approx. 42 minutes). With several units in-
stalled, different switch-on delays are recommended
so that you avoid a mains overload after a power
failure if all units restart automatically.

3.4.2.2.2 Module

The switch-on delay of a module prevents the simul-
taneous start of the modules of a unit. The time can
be adjusted between 0 and 255 seconds.

3.4.2.23 Stage

The switch-on delay of a control stage (e.g. heating,
humidifying, cooling) can be varied between 2 and
255 seconds within a module.

3.4.2.2.4 Temp./humidity.al.

The alarm signals for all exceeded temperature and
humidity limit values can be delayed by 0 to 2,550
seconds in 10 second increments.

3.4.2.2.5 All Alarms

A time delay of 0 to 255 seconds can be set for all
alarms. This is appropriate after a power failure in
rooms under extreme conditions. If the unit starts
automatically, a series of alarm signals does not im-
mediately result.

3.4.2.2.6 Compressor hold

The compressor delay, which is used to increase the
service life of the compressor, by delaying the restart
by the set value, can be adjusted between 1 and 255
seconds.

3.4.2.2.7 Fan

The fan post operation run time can be varied be-
tween 1 and 255 seconds and applies to all modules.

3.4.2.2.8 Louver

The louver start delay applies to the fan in the first
module, if the unit is fitted with louvers. These are
opened simultaneously after the system starts (ex-
cept the louver of the stand-by module), and then
the first fan runs with the set time delay (10 - 2,550
seconds).

3.4.2.2.9 Winter start

The low pressure switch is temporarily bypassed for
the winter start. The bypass time can be adjusted
between 0 and 255 seconds. There will be no “low
pressure fault” alarm within this time.

3.4.2.3 Function Window (Service > Gen. settings >[Function)

return

In this window you set whether the controller is to work
as a supervisor (0= Controller Operation, 1= Supervi-
sor Operation). See Section 4.0. You select which
module (O - 6) is to be operated as a Stand-by Mod-
ule. If 0 is selected there is no stand-by mode. See
Section 4.7. If you set the “Auto start” function to “1”,
the unit is started automatically after a power failure.

If the unit was switched off before the power failure
(local, remote, PC or time switch), it also remains
switched off after the power is restored.

The “Seq type” can be set between 0 and 2. The
meaning of the numbers are as follows:

0= No sequencing

1= Internal sequencing between two units
2= Bus sequencing between 6 units. Refer to
Section 4.4.
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Service Menu (cont.)

3.4.2.4 Interfaces Window

(Service > Gen. settings >[Interfaces)

return

The Baud rate can be set between 0.3 and 19.2 k
Baud. Refer to the printer/computer connection Sec-
tion 6.2 for further settings. The CPU address can be
varied between 1 and 255 and gives the unit (control-
ler) a name in the data exchange with other systems,
(e.g. Building Magement System).

3.4.2.5 Options text Window (Senvice > Gen. seftings >

Alarm text
LC02—Alarm
Aux. alarm 2 UPS—Alarm
Aux. alarm 3 Aux. alarm 3
Aux. alarm 4 Aux. alarm 4

. alarm

return

In this window you enter custom texts for the auxiliary
alarms. Pressing “OK” moves the cursor letter for let-
ter through the text. The letters are changed using “<
>". All upper and lower case letters can be used as
well as numbers and some special symbols.

3.4.2.6 Sequencing Window (service > Gen. settings >

more | return

In this window you enter the number of units which
take part in the sequencing (0 - 6), the number of
stand-by units, the sequencing time (0 - 255 hours)
and the sequencing temperature. Highlight the word
“more” and press “OK” to access the additional “Se-
quencing” dialog window shown next.

5t—By max Temp : a
CW priority : a

return

In this window you can set two outside temperatures,
between which all stand-by units are switched on.

If the outside temperature is lower than “St-By min
Temp” or higher than “St-By max Temp” the stand-by
units are switched off. Conditions for this additional
stand-by unit operation besides this are:

- An outside temperature sensor, which is configured
and connected.

- The values for “St-By min Temp” and “St-By max
Temp” are unequal to zero.

- The bus sequencing (sequencing mode 2) is en-
abled.

The setting “CW priority” is relevant only for the bus
sequencing and is described in Section 4.5.

3.4.3 Data Window  (senice > pafg)

Runtime
Alarm history

Service data
Statistics
Printdata

return

Predominantly, sub-items in which you can view data
are in this menu. You should call up the sub-item
“Service data” after service is complete. You need the
sub-item “Print data” to select the values which are to
be printed and to start printing.

3.4.3.1 Run time Window

(Service > Data >[Runtime]

=

Module

return

You can view the operating hours per module for the
components shown below in the “Runtime” menu:

* Fan

e Compressor(s)
e Electrical heater
e Pump1

e Pump?2

e Humidifier

(©July, 2008)
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Service Menu (cont.)

=

Module

return

Using the “OK” button you change to the numerical
field, and can select a module with the “< >” button
and reset the counter status to 0 by pressing “OK”. If
you do not wish to change anything, you may exit the
numerical field using the “< >” button.

3.4.3.2 Alarm History Window

.
o

Iy
DED=DDDD
OO oo
I N N (D
P ]
N N (D |
B e e Y RN LN NN
FIRIRIRIRIRIRI RIS B
o g
o g B NN

return more

The last 80 alarms which occurred are listed in the
menu item “Alarm history”. The number in front of
the colon specifies the defective module. The letter
“C” stands for controller. A summary of all potential
signals can be found in Section 4.9.2. The alarm
memory is erased by pressing and holding the “RE-
SET” and “OK” buttons, (until the standard window is
visible), while switching on the voltage.

(Service > Data >

3.4.3.3 Service Data Window

Service intervall

Service done S8

Last service G1. B7. 20080

return

The “Service data” menu item represents a control
device. If the service interval entered is exceeded,
the message “Service” appears on the controller.

You can vary the service interval between 0 and 12
months. You bypass the service message by enter-
ing zero. After the unit has been serviced, set the 0
in the “Service done” row to 1 and the current date
appears in the row under it.

3.4.3.4 Statistics Window (senice > Data >[Stafistics|

2:45

RUNT IME EAM TOTAL CYCLES
HiMI H

1. Module  8:98 @ @

2.Module  9:9@ e e

3.Module @:8a a a

4.Module  8:08 8 8

9. Module  9:8@ o o

The compressor statistics show the runtime of the
compressor for each module, the number of cut-ins
(cycles) and the mean runtime which can be calcu-
lated as follows:
Old mean value + new runtime
2

3.4.3.5 Printdata Window (Sewice > Data >[Print datd

return

In the “Print data” window you can select which data
you wish to print out, by setting the “0” to “1”. Print-
ing is initiated by this operation and the “1” changes
back to “0” again. A print command must be triggered
separately for each data area (Temp. data, Alarm his-
tory etc). All print-outs contain the CPU address.

3.4.4 Manual Oper. Window  (service >[Wanual oper)

Cooling
Heating

Humidity
Air

return

Manual control of operation is possible in this menu.
Only those components which are configured in the
Service > Equipment menu or are actually furnished
(e.g. the louver) can be put into operation.

NOTE

When exiting the manual operating level,
manual operation is ended and the unit is
returned to automatic operation.
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3.4.4.1 Modules Window (service > Manual oper. >[Modure]

return

In this dialog window you can select which modules
to operate manually.

3.4.4.2 Cooling Window  (service > Manual oper. >[Cooling)

COMPRESSOR 1 a
SUCTIOMUALVE €8 @

GE~CW UALVE -
GLYCOLFUMP -
DRYCOOLER -

return

You can start the compressor(s), the glycol pump, the
dry cooler and the operation of the suction valve and
the GE valve in this dialog window.

A percentage value appears in the display on compo-
nents which are controlled analogically such as:

- LPHW heater

- Humidifying (2-point control also possible)

- Suction throttle valve

- GE/CW valve

For valves the number indicates the degree of open-
ing of the valves. For the LPHW heater the number
indicates the degree of opening of the LPHW valve.
For humidifying, the number represents a percentage
output indication.

The applicable values for the equipment of the mod-
ules have the following significance:

= Not furnished or off

0 = Furnished but off

1 = 1st stage switched on
2 = 2nd stage switched on
0-99 = 0-99% output

3.443 Heating Window (senice > Manual oper. >Heating)

HEATIH

M1 M2

E-HEATIHG z -
HOTGEAS REH. - -
HWF HEATIHG - -

return

You can start the operation of the electrical heater,
the hot gas heater and the LPHW heater in this dia-
log window. The symbols in the table have the same
meaning as for the configuration of the unit in the
Service > Equipment menu, (see Section 3.4.1).

3.4.4.4 Humldlty Window (Service > Manual oper. >[Humidity]

HUMIDI
M1 Mz

HUMIDIFIER @ -
DEHUMILIFIC. 1 -

return

You can start the humidifier and the operation of the
dehumidifying valve in this dialog window. The com-
pressor can also be put into operation with the “Dehu-
midification” function. The symbols in the table have the
same meaning as for the configuration of the unit in the
Service > Equipment menu, (see Section 3.4.1).

3.4.4.5 Air Window (Service > Manual oper. > Air]

AIR

Mi M2

A 1 1
LOUVER - -

return

You can start the fan and open or close the louver in
this dialog window. (- = open, 1 = closed.) The sym-
bols in the table have the same meaning as for the
configuration of the unit in the Service > Equipment
menu, (see Section 3.4.1).

CAUTION /\

If the fan is switched off, all the other compo-
nents are locked electrically and cannot be
started. If the module is switched off again in
manual operation, all adjustments in the cool-
ing, heating etc. menus are reset to zero and
the controller takes over the control again.

(©July, 2008)
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4.0 OPERATION

4.1 Supervisor Operation

The supervisor takes over the control of the system
if no data transmission to the 1/0 board has been
registered for at least 15 seconds. All the previously
adjusted parameters of the first controller are auto-
matically transferred to the supervisor.

In addition to the current parameters the controller
transmits the “Start/stop” condition to the supervisor.

The controller and the supervisor have the same
CPU address. In case of a request by the RS485
monitoring interface, the supervisor responds only if
the controller does not work.

In normal operation of the first controller the supervi-
sor shows the following display.

[IIlControl Service 12:45
Room K2
59°F 2
55 %RH
Supervisor

P My SATS

If the first controller fails, the supervisor takes over
the control and displays the following alarm signal
window. In addition there is an alarm tone which can
be acknowledged using the reset button.

Info Control Service 1z:45

SiSUFPERUISOR OFERAT.

Room £ 3
09°F @
55 %RH
Supervisor

SATS

If the fault is eliminated and the first controller is
required to take over the control, the supervisor must
be de-energized. The unit must be switched off briefly
for this purpose. After replacing a controller, which is
to act as a supervisor, proceed as follows:

1. Disconnect the controller, which controls in the
normal case, from the mains (disconnect 24 V at
terminal 1). If the controller and the supervisor are
installed in different modules, it is sufficient to switch
off the module, in which the controller is located, at
the master switch.

C6000 Operation & Maintenance Manual

2. Switch on unit.

3. Configure supervisor as supervisor (See Section
3.4.2.3).

4. Disconnect supervisor from the supply voltage
(refer to step 1).

5. Connect controller (connect voltage or switch on
the module concerned).

6. Connect supervisor (refer to step 5).

4-1
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4.2 GE (Water/Glycol) System Operation

Various adjustments can be made during GE opera-

tion to the two major components of the GE unit; The

GE valve and the pump(s) (if furnished). You must
call up the Control > Module functions > Cooling
menu window to make adjustments.

NOTE

In the Service > Equipment > Sensor menu
at least one water temperature sensor must
be configured. If no water temperature sensor
exists for a CW unit, the setting “H” can be
selected. As a result a sensor is simulated with
the value 10%.

You can enter the start temperature in the form of a
positive difference to the setpoint of air temperature
in this window.

M1 MZ
SETFOINMT+R
B2 689

CTARTTENP,
GRADIEMT PR. 1.1 1.1
WATER TEMFP. °F
GE-OFF 7373
DEHUMIDIFIC, 45 43

return

With the aid of the gradient you determine to what

extent a setpoint deviation is to be counteracted. The

smaller the gradient the more the GE/CW valve is
opened at a particular temperature difference to the

start temperature. The term “gradient” is used here in

the sense of a “proportional band”.

Enter the water temperature, in the “GE OFF” field,
at which GE operation is to cease because the water
is too hot and may contribute to the air heating up.
The GE/CW valve is fully open for dehumidifying in
GE operation. In the “GE dehumidification” field you
enter the water temperature setpoint below which
dehumidifying is to cease (in which the GE/CW valve
is fully closed).

If you have selected a GE piping system with one or
two pumps for the A/C unit equipment, you can enter
the start temperature of the pump(s) in the form of a
positive temperature difference to the setpoint in an
additional window.

SETFOIMT+"R
6,2

CTARTTENP,

HYSTERESIS @5
MODULSPANHING 1

return

A pump switch-over occurs after 20 operating hours,
provided 2 pumps are configured (Refer to Service >
Equipment > Cooling, Section 3.4.1.2). If only one
pump is configured, no changeover takes place.

on _| Hysteresis
Glycol .
Pump .
Off ; -
' Starl Temp. Return Air Temp.
1 Glycol Pump
100% : —
GE/CW |
Valve :
0% : -
Setpoint r+—0,5—= Return Air
1.0 Temp.
Start Temp.  Gradient in R
GE/CW Valve
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4.2.1 Glycol Pump Control

The pump control is limited on the modules 1 and 2.
Up to 2 glycol pumps can be configured in each of
the 2 modules. Even if a module executes stand-by
operation, the corresponding pump continues to op-
erate. If 2 glycol pumps are configured in a module,
a sequencing based on time and failure takes place
between these modules (see note below). In this
case the setting “Modulspanning = 1”7 is only effective
if one of the pumps fails.

NOTE

Sequencing based on time and failure means
pump duty will switch between pump #1 and
pump #2 in 10 hour cycles. If one pump is defec-
tive, the other pump will operate instead.

4.2.1.1 Alarms

Pumps with an alarm are always switched off. If both
pumps of a module are defective and if no other
glycol pump is configured, all pumps and compres-
sors are switched off. If at least one glycol pump is
configured in the other module, only the defective
glycol pumps and the compressor of the correspond-
ing module are switched off.

HYSTERESIS B:S
MODULSFAHMING 1

return

A special condition exists if one glycol pump in
module 1 and one pump in module 2 is configured.
Between these two pumps a sequencing based on
time and failure begins if the menu point “Modul-
spanning” is set to “1”. If both pumps are defective,
all compressors are switched off. If the menu point
“Modulespanning” is set to “0”, both pumps will oper-
ate simultaneously. No sequencing will take place. If
a pump is defective, the defective glycol pump and
the compressor of the corresponding module are
switched off.

C6000 Operation & Maintenance Manual
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4.3 Dry Cooler Operation

Dry cooler operation depends on water temperature,
the temperature setpoint of the return air and on the
outside air temperature. For this at least one outside
temperature sensor must be configured in the menu
Service > Equipment > Sensor. A distinction is
made between summer and winter operating meth-
ods.

DRYCOO

M1 M2

WATER TEMF. ©F
[START TEHP. 1 LR
START TEMF. 2 93 95
HYSTERESIS 36 36
STAGE 11

more return

In this dialog window the start temperatures for winter
operation, (Start Temp. 1) and for summer operation,
(Start Temp. 2) can be entered. The hysteresis can
be modified between 0 and 36°F. To avoid the simul-
taneous start of all modules, the start values can be
shifted by adjusting “STAGE”.

Drycooler 1 Drycooler 3

Drygooker 2 Dryfooler 4

|
S E;
50 54 58 62 Start Temperature

(Cooling water)

Example: Start temperature 1: 50°F
Hysteresis: 4
Stage: 2

For the changeover between summer/winter opera-
tion the shift point and the hysteresis can be entered
in the following dialog window.

DRYCOOLER

SUMMER~WINTER

OUTSIDE TEMP.
STHRTTEMF, &1
HYSTERESIS 32

return

The winter operation mode is disabled when the
outside temperature falls below -22°F or if there is
a sensor failure at the outside temperature sensor.
The “Outside Temperature Sensor Failure” alarm is
disabled.

Summer Operation
Y A
Winter Operation
Hystersis
Outside Temperature Sensor
Start Temperature
(©July, 2008) 4-4
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4.4 Bus Sequencing

-6 units maximum can take part in the bus
sequencing.

-For all units the menu point “Seq.type” in the
Service > Gen. Settings > Function menu
must be “2”.

return

-One unit is selected as the sequencing master. This
must be the unit with the CPU address “1” with pref-
erence. Adjustments may be made in the Service >
Gen. Settings > Sequencing menu for this unit only.

Unit 1 Unit 2
CPU =1 CPU=2
I - I -
%) %) %) (%)
> > > >
m m m m

X5 :[11 X5:[12 X5 :[11 X5:12

C6000 Operation & Maintenance Manual

i 12145

return

-The different menu points have the following signifi-
cance:

- Seq. units: The number of units taking part in the
bus sequencing. The units must have CPU address-
es correspondingly from 1 to 6 maximum.

- St.-By-Units: The number units designated as
“stand-by” during normal operation.

- Seq. time: Adjustable between 1 and 255 hours.

0 hours causes the deactivation of the sequencing
function.

- Seq. temp.: Temperature of deadband in °R before
bringing the standby unit into operation.

NOTE
AT °Fahrenheit = AT °Rankine

X5 :[11 X5 :[12

Unit 3
CPU=3
T —
%) %)
> >
m m

Figure 8- Bus Sequencing Diagram

RESTRICTIONS FOR BUS SEQUENCING:

If the units are to be directly connected to a BMS or by a MIB, contact SATS Product Support Group,

(see Section 8.0.).

STULZ
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4.5 Setting CW Priority

The CW-priority setting represents a measure for
saving energy on dual-circuit units (option VFS/CCD/
CCU).

St—By max Temp : ]
CW priority : a

return

By preventing compressor operation until an adjust-
able threshold is reached, the cooling load is exclu-
sively handled by chilled water operation and the
additional operation of stand-by units.

For this purpose it's necessary to set the menu point
“CW priority” to a value which is unequal to zero and
which is the same for all units within the sequencing
circle.

When the sequencing is enabled and no unit within
the sequencing circle requests compressor opera-
tion, the master unit disables compressor operation
for all units. As a result, no unit can start it's compres-
sor. Instead, a stand-by unit is started when an oper-
ating unit would start the compressor due to the room
temperature exceeding the configured compressor
start value.

The compressors of all units are enabled when the
number of units, which is adjusted in the menu point
“CW priority”, would start their compressors as a re-
sult of a rising room temperature. The system returns
to a sequencing mode with the compressors disabled
if no unit started it's compressor because the room
temperature has decreased accordingly.

This control is independent of the water tempera-
ture and the menu point “GE - OFF”. As a result the
sequencing is not interrupted, but continues with the
available units to attain an equal and constant opera-
tion of the units, even in the case of additional units
operating due to alarms.

C1 C2 C3-0On
CW-Prior. =0
4
Cl1 C2 C3-0ff
Comp. 1-3-0On
CW-Prior. =3
y
Comp. 1-3 - Off
Setpoint
(©July, 2008) 4-6
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4.6 BMS Messages

An expansion I/O board provides the capability of supplying up to 8 BMS (Building Management Sytem) signals
(individual fault signals). The assignment of the outputs can be configured in the C6000 according to customer

requirements in the Control > Preferences > Alarm priority menu if these outputs are not used by other func-
tions.

4.6.1 Alarm Number setting (priority) for COS/VFS/CCD/CCU- Basic

The horizontal scale corresponds to module number; vertical scale corresponds to number of alarm.

Module No. —— =

Number 1 2 3 4 5 6
of Alarm [ 1 11 | 21 | 31 | 41 | 51
2 | 2 | 12| 22 | 32| 42 | 52 |Basic /O Board
3 | 3 [13 [ 23 | 33 | 437 53 | Expansion I/0O Board
4 | 4 | 14| 24 | 34 | 44 | 54
5 | 5 | 15| 25| 35| 45| 55
6 | 6 | 16 | 26 | 36 | 46 | 56
7 | 7 | 17| 27| 37| 47 | 57
8 | 8 | 18| 28 | 38 | 48 | 58
9| 9 | 19| 29| 39| 49 | 59
10| 10 | 20 | 30 | 40 | 50 | 60

This table shows the maximum number of alarms, their assignment to the modules and their location on the 1/0
boards (basic or expansion).

47 (©July, 2008)
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4.6.2 BMS alarms which can be occupied by module alarms

A G GE DX Ccw A/G-
Basic
Common Alarm 1 1 1 1 1 1
Compressor 2 n.a. n.a. n.a. 2 n.a. n.a.
Humidifier 2/12/22/32/42/52|2/12/22/32/42/52| 2/12/22/32/42/52 n.a. 2 2
Enable Pump n.a. n.a. 3/13/23/33/43/53 n.a. n.a. n.a.
Pump %% n.a. n.a. 4/14/24/34/44/54 n.a. n.a. n.a.
Dry Cooler 1 n.a. 5/15/25/35/45/55| 5/15/25/35/45/55 | 5/15/25/35/45/55| n.a. n.a.
Dry Cooler 2 n.a. 6/16/26/36/46/56| 6/16/26/36/46/56 | 6/16/26/36/46/56 n.a. n.a.
Dry Cooler 3 n.a. 7117127/137/47/57| 7/17127/37/47/57 | 7/17/27/37/47/57 n.a. n.a.
Dry Cooler 4 n.a. 8/18/28/38/48/58| 8/18/28/38/48/58 | 8/18/28/38/48/58 n.a. n.a.
Sequencing 9and 10 9and 10 9and 10 9and 10 9and 10| n.a.
Louver 1 n.a. n.a. n.a. n.a. n.a. 3
Louver 2 n.a. n.a. n.a. n.a. 6 9
Louver 3 n.a. n.a. n.a. n.a. 7 10
Compressor 3 n.a. n.a. n.a. n.a. n.a. 6
Dehumidify 2 n.a. n.a. n.a. n.a. n.a. 4
Fan 3 n.a. n.a. n.a. n.a. n.a. 5
Heater 3 n.a. n.a. n.a. n.a. 3 7
Heater 4 n.a. n.a. n.a. n.a. 4 8
Humidifier n.a. n.a. n.a. n.a. 5 n.a.

Certain alarms can be assigned to specific alarm relays on either the basic or expansion I/O-board. If they are
needed, they occupy normally available BMS alarm slots.

Example:

The humidifier alarm in the first module of an A-unit is assigned to alarm relay 2. If additionally a sequencing

is used, it occupies the alarm relay 9 and 10. In this case the alarm relays 3 through 8 are free for other BMS

alarm assignments.

(©July, 2008)

STULZ

| or——
Air Technology Systems, Inc.

4-8



4.7 Standby Operation

Only one module can be configured as a stand-by
module in a unit. The stand-by module is not started
when the unit is started. If the stand-by module is
equipped with louvers, these remain closed when the
unit starts. The stand-by module runs with its own
parameters and is only started by one of the following
alternatives:

1. False start

2. Alarm start

3. Sequencing

4. Manual start
It is possible to switch off the stand-by module by
entering a “0” in the “Stand-by module” field in the
Service > Gen. Settings > Function dialog window.

In this case the module which failed previously starts
again.

4.7.1 False start (highest priority)

The stand-by module is started if one of the following
conditions occur in a module:

- Air flow failure

- Compressor HP fault

- Compressor LP fault- Heater fault

- Humidifier defective

- Ultrasonic defective
The defective module is switched off and the louvers
(if furnished) are closed.

4.7.2 Alarm start (average priority)

The stand-by module is switched on at 2.7°Rankine
or 3% rel. humidity before reaching the limit values of
the main type of control. The hysteresis is 1.8°Ran-
kine and 3% rel. humidity.

C6000 Operation & Maintenance Manual

4.7.3 Sequencing (lowest priority)

Redesignating the stand-by module within a unit, is
carried out once a week. The stand-by module ex-
changes with modules which are identically equipped
in sequence through the unit. The same equipment
relates to:

- Cooling (compressor)

- Heating (electrical heater 1+2, refrigerant
heater)

- Humidifying
- Dehumidifying

The parameters between the old and the new stand-
by module are replaced in the process.

If the stand-by module is already started (due to false
start, alarm start or manual start), the sequencing
between the modules is suspended for this time. The
weekly redesignation time shifts accordingly.

The weekly redesignation time can be reduced to 5
minutes for test purposes.
1. Switch off the voltage.

2. Simultaneously press and hold the “>” button and
the “RESET” button.

3. Switch on the voltage.

4. Release the buttons when the standard window is
visible.

Switching the voltage “On” and “Off” sets the redesig-
nation time back to 1 week.

4.7.4 Manual start

The stand-by module can be started and stopped
manually. This may be done in the Service > Manual
oper. menu. Refer to Section 3.4.4.

4-9
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4.8 Sensor Broken

Valid value range of sensors. (values measured by
the sensor without readjustment)

Return air temperature ...... 35 to 122°F
Return air humidity ............ 2t0 100 % R.H.
Supply air temperature ...... 35 to 122°F

210100 % R.H.
-52 to +122°F

If one of the measured values is outside the specified
range, the sensor is recorded as defective.

Supply air humidity ............
Water temperature.............

If only part of the sensor (temperature or humidity)
fails, the operative part continues to be used for the
control. The defective part is ignored and no longer
contributes to the control.

If sensors for return air and supply air are furnished,
the defective sensor is switched off and the appropri-
ate type of control for the operative sensor is select-
ed. For example, if the return air sensor fails during
return air control with supply air limitation, the Room
temperature display in the Standard window defaults
to 32°F and the controller changes over to Supply Air

Control.
CAUTION A

In this case, the new setpoint values are the
supply air setpoint values, which can be ad-
justed in advance by switching over to supply
air control in the Service > Gen. settings >
Control > Control type menu.

If a water sensor fails, the pumps and the dry cooler
are switched on permanently if cooling or dehumidifi-
cation is required.

4.9 Fault Signals

4.9.1 General Definition

A signal always appears on the display if the entered
setpoint limit values are exceeded or if any com-
ponents of the A/C unit do not work satisfactorily. A
distinction is made between four types of signals.

Limit value alarms - Occur if the entered limit values
of the control of the A/C unit are not achieved or are
exceeded. Limit value alarms are also evaluated in
stop-mode.

Unit faults - Occur if components of the A/C unit are
defective or do not work satisfactorily. If a component
is not configured, the corresponding alarm is passive.
Example: If no electrical heater in the 2nd module is
configured, the alarm input “electrical heater fault”

in the 2nd module has no function. The “Fire Alarm”
and “Water Alarm” are also evaluated in stop-mode.
Other alarms are only evaluated in start-mode.

Internal faults - Occur when there is a controller or
peripheral components which are defective or do not
work satisfactorily.

Information texts - Occur if service intervals have
expired.

An alarm is indicated by a text output on the display
of the controller, an audible signal and by the alarm
lamp (LED) lighting-up. If you press the “RESET”
button, the alarm tone stops. Pressing the “RESET”
button again cancels the alarm however, the alarm
occurs again if the cause of the fault has not been
eliminated. When an alarm signal is activated, the
cause of the fault must be eliminated in according to
the troubleshooting instructions for the A/C unit.

CAUTION A

If an alarm input is provided with +24V, no alarm
is displayed. If voltage is interrupted (i.e. broken
cable), the alarm is displayed.

(©July, 2008)
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4.9.2 Possible Fault Signals on Display

Display

Delay

C6000 Operation & Maintenance Manual

Cause

Limit value alarms

Room temp. too high
Room temp. too low
Supply air temp. too high
Supply air temp. too low
Water temp. too high
Water temp. too low
Room humidity too high
Room humidity too low
Supply air hum. too high
Supply air hum. too low

Unit faults

Air flow failure
Compressor LP fault
Compressor HP fault
Electrical heater fault
Humidity defective
Filter fault
Supervisor alarm

Adjustable between
0 - 2550s

D (15s after US)
0-255s after CS
3s+D

3s+D

3s+D

D (15s after US)
D

Actual value greater than limit value
Actual value less than limit value
Actual value greater than limit value
Actual value less than limit value
Actual value greater than limit value
Actual value less than limit value
Actual value greater than limit value
Actual value less than limit value
Actual value greater than limit value
Actual value less than limit value

Fan failure/V-belt defective
Insufficient refrigerant
Compressor defective

Heater has over-heated
Steam humidifier defective
Filter contaminated

Actual value > or < limit value

Conductivity failure 30 min. +D Conductivity > 5y S
Ultrasonic fault 30 min. +D Conductivity > 20u S
Pump 1 fault 3s+D Glycol pump (GE) defective
Pump 2 fault 3s+D Glycol pump (GE) defective
Dry cooler fault 3s+D Dry cooler defective
Water alarm D (10s after US) Water in raised floor
Auxiliary alarm 1D (10s after US) (Freely assignable)
Auxiliary alarm 2D (10s after US) (Freely assignable)
Auxiliary alarm 3D (10s after US) (Freely assignable)
Auxiliary alarm 4D (10s after US) (Freely assignable)
Legend:
D: Adjustable delay 0-255s (as set in the Service > Gen. settings > Time delay menu)
US:  Unit start
CS: Compressor start
4-11 (©July, 2008)
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Display Delay Cause

Fire alarm Os Fire/Fire alarm system

RT sensor broken Room temp. sensor cable broken

RH sensor broken Room humidity sensor cable broken
ST sensor broken 5s Supply air temp. sensor cable broken
SH sensor broken Supply air humidity sensor cablebroken
WT sensor broken Water temp. sensor cable broken

E1 sensor broken External sensor 1 cable broken
Internal faults

I/O transmission fault Os Connection or I/O board defective
Information texts

Maintenance required 8 o’clock* Service interval expired

Supervisor Os Controller works as supervisor
Supervisor failure Os Supervisor defective

Supervisor operation 30s Controller defective

Stand-by module active Os Main module defective/limit valueexceeded
UPS Os Uninterrupted power supply

*The information/alarm is delayed until 8 o’clock the next day.

(©July, 2008)
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4.10 Factory Default Settings
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Temperature Min Setpoint Max °C Menu
Room 5 24.0 35 Control > Temperature
Supply air 5 — 35
Water 20 — 45
Humidity Min Setpoint Max %R.H.
Room 5 45 90 Control > Humidity
Supply air 5 — 90

Setpoint + Kelvin

M1 M2 M3 M4 M5 M6 Menu
Compressor Control > Module functions >
Start temp. 1 0.7 1.1 1.5 1.9 2.3 2.7 Cooling > Compressor
Start temp. 2 0.9 1.3 1.7 2.1 2.5 2.9
Hysteresis 0.7 0.7 0.7 0.7 0.7 0.7
Suction valve

Control > Module functions >

Start temperature 0.0 04 0.8 1.2 1.6 2.0 Cooling > Suction valve
Gradient, proportional 0.5 0.5 0.5 0.5 0.5 0.5
GE/CW valve Control > Module functions >
Start temperature 0.1 0.5 0.9 1.3 1.7 1.9 Cooling > GE/CW valve
Gradient, proportional 0.6 0.6 0.6 0.6 0.6 0.6
GE off 23 23 23 23 23 23
GE dehumidification 7 7 7 7 7 7
Glycol pump Control > Module functions >
Start temperature 0.1 0.1 0.1 0.1 0.1 0.1 Cooling > Pumps
Hysteresis 0.3 0.3 0.3 0.3 0.3 0.3

Water temperature
Drycooler Control > Module functions >
Start temperature 1 10 11 12 13 14 15 Cooling > Drycooler
Start temperature 2 34 35 36 37 38 39
Hysteresis 2 2 2 2 2 2
Stage 1 1 1 1 1 1

Outside temperature (Changeover summer/winter)
Start temperature 16 16 16 16 16 16
Hysteresis 2 2 2 2 2 2
4-13 (©July, 2008)
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Setpoint — Kelvin

M1 M2 M3 M4 M5 M6 Menu
Electrical heater Control > Module functions >
Start temperature 1 1.5 2.0 2.5 3.0 3.5 4.0 Heating > E-heating
Hysteresis 1 0.5 0.5 0.5 0.5 0.5 0.5
Start temperature 2 2.0 2.5 3.0 3.5 3.5 3.5
Hysteresis 2 0.5 0.5 0.5 0.5 0.5 0.5
Hotgas reheat Control > Module functions >
Start temperature 1.0 1.5 2.0 2.5 3.0 3.5 Heating > Hotgas reh.
Hysteresis 0.5 0.5 0.5 0.5 0.5 0.5
LPHW valve Control > Module functions >
Start temperature 1.5 2.0 2.5 3.0 3.5 4.0 Heating > HWR-valve
Hysteresis 0.5 0.5 0.5 0.5 0.5 0.5
Start proportional 1.5 2.0 2.5 3.0 3.5 4.0
Gradient, proportional 0.5 0.5 0.5 0.5 0.5 0.5

Humidification

Start humidity
Hysteresis

Start, proportional
Gradient, proportional

Dehumidification

Setpoint - % rel. humidity

o
= O O,
= O O,

Setpoint + % rel. humidity

Control > Module functions >
Humidification

Control > Module functions >

Start temperature 10 15 20 25 30 35 Dehumidification
Hysteresis 10 10 10 10 10 10
Setpoint - Kelvin

Dehumidifying stop 5 5 5 5 5 5
Fan Control > Module functions >
Start temperature 0 0 0 0 0 0 Air
Gradient, proportional 1.0 1.0 1.0 1.0 1.0 1.0

Settings Function

Type of control Room Supervisor 0

Stand-by module 0

Time Delays (in Seconds) Autostart 1

System 0 Seq. type 0

Module 2

Stage 5 Interfaces

Temp./humidity alarm 40 Baud rate 9,6

All alarms 0 Parity N

Compressor interval 240 Stop bit 1

Fan 60 Data flow RTS

Louver 90 CPU address 1

Winter start 180
(©July, 2008) 4-14
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4.11 Control Diagrams

4.11.1 Temperature Control ‘
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Figure 9- Temperature Control Diagram

4-15

(©July, 2008)
STUILZ

I
Air Technology Systems, Inc.



C6000 Operation & Maintenance Manual

4.11.2 Humidity Control
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Figure 10- Humidity Control Diagram
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5.0

HARDWARE DESCRIPTION

5.1 Controller
5.1.1 Controller PC Board

C6000 Operation & Maintenance Manual

5.1.2 Control Board Technical Data
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Dimensions:

Voltage Supply:

Power Consumption:
Fuse:

Download and Printer
Interface:

I/O Board Interface:
Operating Temperature:
Storage Temperature:

10.6 x4.3x1.6in.

24 (+/- 15%) VAC

14 VA

1 Amp, time delay

RS 232 cable (approx.
32 ft. long)

RS 485

41°F to 104°F

-22°F to 140°F

o B o 8| oz
“H & mg 7| am
= 52 o] | o|mm:
(& 2 & BT
i o |
8 :| /=2 3| Fer g
] mmf alee
g Lo o
L] I;l
R71 €16
RS1
E

&

8y

Figure 11- C6000 Control Board Layout

———— RS 485- Interface Driver

| Jumper X2: Bus Termination for RS 485 monitoring

Pos. A: set, Pos B: not set

Jumper X3: Bus Termination for RS 485 I/O Board
Pos. A: Set, Pos B: Not Set

RS 232

| ——CPU
RS 485 1/0 Board Interface
RS 485 Monitoring Interface

Real Time Clock

Jumper X6: Pos A: Controller in Download Mode

| Contrast Adjustment for Display

5-1
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5.2 Standard 1/0 Board

5.2.1 Standard I/O Board Connection Assignments

pl kL _E - O O wl ][]
< Aout1 - STULZ C6@08 M14959 =5 c38 I%I m:||:||:| Bus-H
R9 RIB Na Ra4| e
BND mo[ ]y [eis g e - v Bus-L
R? R17 |] R3 E 8 S-()S—()
~— |Routz s o () ) R e Ain 7
BND R11 Ria =B o I:lo 2z g I:ET GND
R13 (] R16 o :l I:l &= r
~@— |Rout3 R12 37 RIS n_'i;z g - ey +15V
BND g 8 Ee 8 L] Ain 6
~4— |Aoul4 gl:l Kt " DDZ:‘: E:Esg GND
BND ’ - o |j +15V
el L SD [ Ain 5
com J 1] ] GND
C NC 1 ED = = " | 1REN4 +15V
| A| e J3
M2 §|:| I%I B CE' o7 Vﬁl:g%. E Ij Ain 4
| " - ] w2 Ain 3
NC 2 gl:l g GND
Nﬂ 3 D Ics [R4D)] 12 V3| m:E: ﬁ +15V
COM3 ﬁl:l1 P ] vq:'% 2 Ain 2
NC 3 R77 K4 1t 1w ° L Ain 1
NO 4 o : sl ]g o GND
COM4 |:| «op y e w +15V
o e SNy i -
ND 5 I:l ul L H Din 9
COMS Re8) wel [T Pin 8
ws | L s =] pin 7
NO 6 Rt ke . o Din 6
COMB [ | 4[} | )\ - | Din 5
NC 6 |_1 H-I b & I M bed U Din 4
NO 7 e i g e Pin3
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CoMg I:Ims xe . L] = Rit B GND
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B 2 o D.Tm 8 o "o oW !

Figure 12- Standard I/O Board Layout

5.2.2 Standard 1/0 Board Technical Data

Dimensions:

Voltage supply:
Power consumption:
Fuse:

Sensor input:

Alarm inputs:
Outputs:

I/O board interface:
Adjustable addresses:
Operating temperature:
Storage temperature:

6.7 x 7.0 x 1.2 inches

24 (+20%/-15%) VAC

17 VA (I/0 Board + Exp. I/O Board)
2A time-lag

7 (0-20mA), (4-20mA), (0-10V)

10 (24 VAC/DC) 24V = no alarm

4 analog 0-10 VDC load rating: 20 mA 8 digital 24 VAC max. 6 A
RS485

1to6

41°F - 104°F

-22°F - 140°F

(©July, 2008)
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5.2.3 Address Switch Positions

ON

OFF

ON

OFF

C6000 Operation & Maintenance Manual

4 5 6 12 3 4 5 6 T2 3 4
ON ON
Module 1 Module 3
OFF OFF
5 6 1 2 3 4 5 6 1 2 3 4
Module2 " Module 4 "
OFF OFF
5.2.4 Connection Assigment by A/C Unit Type
Pin Design. COSI/VFS CCD/CCU
33 Aout 1 GE/CW-valve GE/CW-valve 1
34 GND or actual or actual
X13 Screen temperature temperature
35 Aout 2 Humidifier Humidifier
36 GND or actual or actual
X14 Screen temperature temperature
37 Aout 3 Suction valve Suction valve,
38 GND or CW-valve 2 or
X10 | Screen actual humidity actual humidity
39 Aout 4 LPHW-valve, SCR LPHW-valve, SCR
40 GND Reheat, Fan Reheat, Fan
X9 Screen Frequency Converter Frequency Converter
41 Dout 1
42 Dout 1 Fan 1 Fan 1
43 Dout 1
44 Dout 2
45 Dout 2 Compressor 1 Fan 2
46 Dout 2
47 Dout 3
48 Dout 3 E-reheat 1 E-reheat 1
49 Dout 3
50 Dout 4 E-reheat 2 E-reheat 2
51 Dout 4 Hotgas reheat Hotgas reheat
52 Dout 4 LPHW reheat LPHW reheat
53 Dout 5
54 Dout 5 Pump Down Pump Down
55 Dout 5
56 Dout 6
57 Dout 6 Alarm 1 Alarm 1
58 Dout 6
59 Dout 7 Humidifier Humidifier
60 Dout 7 or Alarm 2 or Alarm 2
61 Dout 7
62 Dout 8
63 Dout 8 Compressor 2 Fan 3
64 Dout 8

Module 5

Module 6

5-3
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5.2.4 Connection Assigment by A/C Unit Type (cont.)

Pin Design. COSIVFS CccD/CcCU
1 24V+ I/O-Board supply I/O-Board supply
2 GND
3 GNDA
4 Din 1 Airflow 1 Fan 1 Fall
5 Din 2 High pressure 1 CW-valve selector
6 Din 3 LP 1 Fan 2 Fail
7 Din 4 E-reheat fail 1/2/3 E-reheat fail 1/2/3
8 Din 5 Filter alarm Filter alarm
9 Din 6 Humidifier failure Humidifier failure
10 Din 7 Water detector Water detector
11 Din 8 High pressure 2 CW-valve 1/2 Selector
12 Din 9 LP 2 Fan 3 Fail
13 Din 10 UPS UPS
14 15V+ T/H sensor 1 T/H sensor 1
15 GND
16 Temp. Room/Return Air Room/Return Air
17 Humidity Room/Return Air Room/Return Air
X4 Screen
18 15V+ T/H sensor 2 T/H sensor 2
19 GND
20 Temp. Supply Air Supply Air
21 Humidity Supply Air Supply Air
X5 Screen
22 15V+
23 GND
24 Ain 5 Water temp.sensor Water temp.sensor
X6 Screen
25 15V+ Outside Outside
26 GND temp.sensor temp.sensor
27 Ain 6 or Set temperature or Set temperature
X7 Screen
28 15V+
29 GND Set humidity Set humidity
30 Ain7
X8 Screen
31 Low Bus 2 Bus 2
32 High
X12 Screen

(©July, 2008)
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5.2.5 Jumper Positions

ay
F win
A | %
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T = — = 1 1
O C Cjmme C oM Cuwch o | Cc uwwn
Pl B == e L R b T =i e | s B N |
‘KD L+ O O+ O+ I+ O O Lo ‘
J1 J2 J3 J4 J5 J6 J7  J8
Figure 13- 1/0 Board Jumper Positions
Jumper Assignment Position A Position B

J1 : Return Air Temperature
J2 : Return Air Humidity

J3 : Supply Air Temperature
J4 : Supply Air Humidity Voltage Current

J5 : Water Temperature
J6 : Outside Air Temperature

J7 : External Analog 7

J8 : Bus Termination Enabled Disabled
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5.3 Expansion I/O Board

5.3.1 Expansion /O Board Connection Assignments

mr T
18 R7 | O K4 K3 RE [ E’“
N0 12 - | o
] com? I o |
\C 12 ks RS NO 11
1 ro ks K2 iad NC 10
— o _ — COM10
cue 13 R [ s
— — NC 9
———{N0 14 uH e = &
e Ul o
NC 14 ! i
—|N0 15 s ke 0t imn i
oo P ] Dinl7
o — D!n16
e ] ot | Din15
o~ — ” o ; Dinl4
T e I S —
— »{Dintt ] = | g':IDDA
—>|Din1? " STULZ Copee i 7 .
4 | . l
X2 Miee o L—m—- Wl o

Figure 14- Expansion 1/0 Board Layout

5.3.2 Expansion I/O Board Technical Data

Dimensions:
Power Consumption:
Alarm Inputs:

4.1x4.0x1.2inches
17 VA (1/0 Board + Ext. /0 Board)
8 (24 VAC/DC) 24V = no alarm

S

Outputs: 8 digital 24 VAC max. 6 A
Operating Temperature: 41°F - 104°F
Storage Temperature:  -22°F - 140°F
(©July, 2008) 5-6
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5.3.3 Expansion I/O Board Connection Assigment According to Unit Type

Pin Design. COS/VFS ccb/ccu
1 GND I/O-Board supply I/O-Board supply
2 GNDA
33 Din 11 Pump 1 Failure Pump 1 Failure
34 Din 12 Pump 2 Failure Pump 2 Failure
3 Din 13 Dry Cooler Failure Dry Cooler Failure
4 Din 14 Sequencing Sequencing
5 Din 15 External Alarm 1 Power A Failure
6 Din 16 Compressor Lockout Power B Failure
7 Din 17 Phase Failure Phase Failure
8 Din 18 Remote On/Off Remote On/Off
9 Dout 9 Pump Enable Pump Enable
10 Dout 9 or Alarm 3 or Alarm 3
11 Dout 9
12 Dout 10 Pump 1/2 Pump 1/2
13 Dout 10 orAlarm 4 orAlarm 4
14 Dout 10
15 Dout 11
16 Dout 11 Dry Cooler 1 /Alarm 5 Dry Cooler 1 /Alarm 5
17 Dout 11
18 Dout 12
19 Dout 12 Louver 1 Louver 1
20 Dout 12
21 Dout 13
22 Dout 13 E-reheat 3 E-reheat 3
23 Dout 13
24 Dout 14
25 Dout 14 Alarm 2 Alarm 2
26 Dout 14
27 Dout 15
28 Dout 15 Alarm 9 / with Sequenc. Alarm 9 / with Sequenc.
29 Dout 15 copy Alarm 1 copy Alarm 1
30 Dout 16
31 Dout 16 Sequencing relay / Sequencing relay /
32 Dout 16 Alarm 10 Alarm 10

S-7 (©July, 2008)
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5.4 Temperature/Humidity Sensor

| Temperature Sensor

Dﬁl// Humidity Sensor

2

4-20mA: 0 - 122°F
4-20mA: 0 - 100% RH
15-28 VDC

Figure 15- Temperature/Humidity Sensor Layout

5.4.1 Sensor Calibration A
CAUTION

1. Temperature

The re-adjustment of the resistors is not
The fine tune adeStment takes place in the Control necessary. Damaging the seal will void the
> Preferences > Sensor adjust menu. warranty.

2. Humidity (R2)

The fine tune adjustment takes place in the Control
> Preferences > Sensor adjust menu.

(©July, 2008)
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6.0 SYSTEM CONFIGURATION é
CAUTION
6.1 Wiring Diagrams With separate installation of modules, the maximum
The following Diagrams are for reference only. For permitted cable length between the controller and
detailed wiring information specific to your system, I/O board is 490 feet. The maximum allowable cable
refer to the electrical drawing(s) provided with your length between two /O boards is 160 feet. For this a
unit. special data cable must be used.

6.1.1 Wiring C6000 with 1/0 Boards

I
1st Module I 2nd to 6th Module
Bus2L, 14 RS89
Controll UL,

ontroller Bus2H. 13 I/ / I/ /

32 31 : 32 31

With max. equipment H L H L
/0 Board I 1/0 Board
1 : [ |
Expansion | Expansion
/O Board : /O Board

6.1.2 Wiring C6000 with Supervisor in 1st Module

1st Module : 2nd to 6th Module
Supervisor |Bus2L, 14 I
Bus2H, 13 |
56|78 I
I
/S |
a4 I
/S
I
I
516 |7 |8
Bus2L 14 < I
Controller Bus2H.1- RS485
/ /
32 31 | 32 31
H L I H L
1/0 Board I I/O Board
|
61 (©July, 2008)
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6.1.3 Wiring C6000 with Supervisor in 2nd Module

I
I
1st Module : 2nd to 6th Module

| RS485

Bus2L, 14 |
Il d /
Controller Bus2H. 13 I/ | I/
56 7] 8 |
32 31 | 32 31
H L | H L
1/0 Board 1/0 Board
I
I
Control line [
5/6[7]|8
. Bus2L, 14 <
Supervisor Bus2H, 13
1/0 Board
3rd Module
(©July, 2008) 6-2
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6.2 Printer Connection

A printer with a RS232 serial interface is required

for connection to the C6000 controller. The printer is
connected to the Sub-D-plug (X4) of the controller
printed circuit board (See Figure 11 and 12). Further
adjustments can be made in the Service > Gen. set-
tings > Interfaces dialog window, corresponding to
the technical data on the printer.

return

A wide range of adjustments under port 0 may be
selected here.

The following adjustments are possible:

Baud rate

(in k Baud) | Parity ‘ Stop bit ‘ Data flow
1.2 N ‘ 1 ‘ RTS
24

4.8

9.6 N: None

19.2

NOTE

The settings at the C6000 must agree with the
settings on the printer.

Printer cable (minimum assignment):

Printer C6000
Sub-D; 25 pins Sub-D; 9 pins
Male F
2 2
3 3
7 5

C6000 Operation & Maintenance Manual

6.3 Computer Connection

You can also print the data to a file and have it
displayed on a screen. For this you use the same
RS232 modem connection cable you use for loading
new software (see Figure 12).

Assignment:

PC C6000
Sub-D; 9 pins

Female

2

3 X
5

6-3
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6.4 Loading New Software

Before you start loading new software, it is wise to note or print out the parameters set, as all parameters must
be re-entered after loading the software. For loading software in the flash-EPROM of the C6000, you must
connect the C6000 to your PC/laptop by means of a RS232 modem connection. After this the jumper X6 must
be moved to position A. Power to the C6000 controller must then be switched “Off” and then “On” again. The
C6000 is now in the download mode. Start the software “Service C6000” on your PC. A window will appear
describing how to operate the software. If you don’t possess the software “Service C6000” or “Service C7000”,

you can order it via e-mail.

C6000 Control Board
(See Figure 11)

Position A Position B

X4

RS 232 Modem connection with
2x 9 poles Sub-D (Female)

9353888 0diaer (0 o=
T Ell]ﬁil ‘B "Oﬂ - QEE:{]:-}
g ﬁﬂ"‘;fﬂﬂgﬂu@“mﬁ“:”h" oY
R =Y
Gy

COM 1
Interface

Figure 16- Software Loading Diagram

*system requirements: Windows 95/98/NT/2000

After the new software has been loaded, the jumper X6
must be moved back in position B. After this power to
the C6000 controller must be switched “Off” and “On”
again. When switching on, ensure that the new version
number as well as the connected I/O cards is correctly
displayed.

In the next step, all parameters must be readjusted
if they deviate from the default settings. The default
language is English. If you require another language,
you can change this in the Control > Preferences >
Languages menu.

(©July, 2008)
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6.4.1 Installation of New Software While
Keeping the Parameters

The installation of new software without losing the
parameters is only possible with the presence of a
supervisor. The following description is based on a 2-
module unit with the controller in the first module and
the supervisor in the second module.

1. Switch off all modules at the main switch (if ap-
plicable) or disconnect the 24V supply voltage from
the controllers.

©)
©)

2. Disconnect the cable between the controller and
the supervisor (pin 5 to 8 on the C6000).

T

3. Load the supervisor software.

3

— ./
"

4. Switch on only the module with the supervisor
(mod. 2). The new software is reset from supervi-
sor mode back to controller mode. Set the supervi-
sor function to “1” in the Service > Gen. settings >
Function menu.

[ [

4

s

Transmission
4—

C6000 Operation & Maintenance Manual

5. Switch on the module with the controller also
(mod. 1). The parameters will now be transmitted
from the controller to the supervisor. When the beep-
ing stops, the transmission is completed (approx. 1
min.).

— —
/
v
6. Switch off all modules.
— —
@) 0O

7. Load the controller software.

= = X
__~

8. Switch on module 1 only. Set the supervisor func-
tion to “1” in the Service > Gen. settings > Function
menu. The C6000 in module 1 is now in supervisor
operation mode also.

— S —
/7
[
9. Switch off module 1.
/| |

6-5
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10. Switch on module 2 only. Set the supervisor func-
tion to “0” in Service > Gen. settings > Function
menu. The C6000 in module 2 is now in controller
operation mode.

]

11. Switch on module 1. The parameters will now be
transmitted from the controller (now module 2) to the
supervisor (now module 1). When the beeping stops,
the transmission is completed (approx. 1 min.).

./ ./

7

Transmission
—

12. To restore the original configuration, set the
supervisor function to “0” in module 1 and set the
supervisor function to “1” in module 2 in the Service
> Gen. settings > Function menu.

13. Switch off all modules and replace the cable be-
tween the controller and the supervisor, (pin 5to 8 on
the C6000). The changes will take effect after switch-
ing on all modules.

T
o |0

Legend:

Switch on the voltage.
Switch off the voltage.

O >
I

(©July, 2008)
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7.0 TROUBLESHOOTING
7.1 Alarm Windows

The following is typical display for an alarm condi-
tion. (Example: 1/O Transmission Failure). The word
“ALARM” appears highlighted in black and a mes-
sage describing the reason for the alarm is displayed
in the window.

Signal in display

OIlcontrol Service 1e:32
Room  #

20,6 °F

53 *%RH
B SATS

1-6: 1/O transmission failure
Cause/Elimination

The data transmission with an 1/O board is no longer
operative. The number before the colon shows in
which module the fault has occurred.

1. First check whether the configuration of the A/C
unit agrees with the actual equipment in the Ser-
vice > Equipment > Modules menu.

2. Check the settings on the address switches on the
Standard 1/O board, (see Section 5.3.3).

3. Ensure the cable connections are in accordance
with the appropriate wiring diagram, (see Section
6.1).

4. If the fault still occurs after these checks and is
continuous from a particular module onwards, the
cable connection between the last operative mod-
ule and the first defective module may be defec-
tive. Otherwise the I/O board is defective and must
be replaced.

C6000 Operation & Maintenance Manual
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8.0 PRODUCT SUPPORT GROUP

SATS provides to its customers a Product Support
Group (PSG) which not only provides technical sup-
port and parts but the following additional services,
as requested: performance evaluations, start-up as-
sistance and training.

8.1 Technical Support

The SATS Product Support Group is dedicated to the
prompt reply and solution to any problem encoun-
tered with a unit. Should a problem develop that can-
not be resolved using this manual, you may contact
PSG at (240) 529-1399 Monday through Friday from
8:00 a.m. to 5:00 p.m. EST. If a problem occurs after
business hours, dial the page number (301) 414-
4514 and follow the steps below:

1.  Wait for the dial tone.

2. Dial your telephone number (including area
code).

3. Press the pound (#) key.

4. Wait for a busy signal.

5. Hang up the telephone.

One of our service technicians will return your call.
When calling to obtain support, it is vital to have the
following information readily available, (information is
found on unit’s nameplate):

*  Unit Model Number
*  SATS Iltem Number
»  Unit Serial Number
»  Description of Problem

8.2 Obtaining Warranty Parts

Warranty inquires are to be made through the
Product Support Group at (240) 529-1399 Monday
through Friday from 8:00 a.m. to 5:00 p.m. EST. A
service technician at SATS will troubleshoot the sys-
tem over the telephone with a field service technician
to determine the defect of the part. If it is determined
that the part may be defective a replacement part will
be sent UPS ground. If the customer requests that
warranty part(s) be sent by any other method than
UPS ground the customer is responsible for the ship-
ping charges. If you do not have established credit
with SATS you must provide a freight carrier account
number.

A written (or faxed) purchase order is required on
warranty parts and must be received prior to 12:00

p.m. for same day shipment. The purchase order
must contain the following items:

»  Purchase Order Number

+ Date of Order

+ SATS Stated Part Price (obtained from PSG)
*  Customer Billing Address

*  Shipping Address

*  Customer’s Telephone and Fax Numbers

+ Contact Name

*  Unit Model No., Serial No. & SATS Item No.

The customer is responsible for the shipping cost
incurred for shipping the defective part(s) back to
SATS. Return of defective part(s) must be within 30
days at which time an evaluation of the part(s) is
conducted and if the part is found to have a manufac-
turing defect a credit will be issued.

When returning defective part(s) complete the Return
Material Authorization Tag and the address label
received with the replacement part.

See SATS Standard Warranty located in section one
of this manual.

8.3 Obtaining Spare/Replacement Parts

Spare and replacement parts requests are to be
made through the Product Support Group by fax
(301) 620-1396, telephone (240) 529-1399 or E-mail
(parts@stulz-ats.com). Quotes are given for specified
listed parts for a specific unit.

SATS accepts Visa and MasterCard. SATS may ex-
tend credit to its customers; a credit application must
be prepared and approved (this process could take
one week).

A 25% minimum restocking charge will be applied on
returned stocked parts that were sold as spare/re-
placement parts. If the returned part is not a stocked
item, a 50% restocking charge may be applied.
Additionally a Return Material Authorization Number
is required when returning parts. To receive credit
for returned repair/replacement parts, the parts must
be returned to SATS within 30 days of the purchase
date. Spare part sales over 30 days old will be
considered final and the parts will remain the sole
property of the ordering party.

(©July, 2008)
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A/C-

BMS -

BTU/Hr -

OC_

CW -

DX -

ESD -

oF .

FOB -

Glossary

Definition of Terms and Abbreviations

Air Conditioner MIB - Multi Interface Board

Building Management System PSG - Product Support Group

British Thermal Units Per Hour PSI - Pounds per Square Inch

Degrees Centigrade PSIG - Pounds per Square Inch Gauge
Chilled Water °R - Degrees Rankine

Direct Expansion R.H.- Relative Humidity

Electrostatic Discharge SATS - Stulz Air Technology Systems, Inc.
Degrees Fahrenheit V- Volt

Freight on Board VAC - Volt, Alternating Current

Feet W/G - Water Glycol (GE)

Water Glycol (WG)
Inches

Degrees Kelvin
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Globally close to you

Stulz-ATS, located in Frederick, MD USA, is part of The STULZ
Group with headquarters in Hamburg, Germany and production
facilities world wide. Our network of manufacturer’s representatives
and sales partners span the globe, providing innovative solutions to

your unique environmental control needs.

www.stulz-ats.com

Stulz Air Technology Systems, Inc.

1572 Tilco Drive, Frederick, Maryland 21704
Phone: (301) 620-2033, Fax: (301) 662-5487
Email: info@stulz-ats.com

STULZ www.stulz-ats.com

Air Technology Systems, Inc.
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